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Introduction
Cisco Finesse is a next-generation agent and supervisor desktop designed to provide a collaborative experience
for the various communities that interact with your customer service organization. It helps improve the customer
experience while offering a user-centric design to enhance customer care representative satisfaction as well.

Cisco Finesse provides:

• A browser-based administration console and a browser-based desktop for agents and supervisors; no
client-side installations required.

• A single, customizable "cockpit", or interface, that gives customer care providers quick and easy access
to multiple assets and information sources.

• REST APIs that simplify the development and integration of value-added applications and minimize the
need for detailed desktop development expertise.

Finesse configuration changes are permitted on only the primary server. Access to Finesse administration
console on the secondary server is read-only.

When you attempt to save the changes in Finesse administration console on the secondary node, you receive
a message that administration on the secondary node is read-only.

Cisco Finesse Administration Console

Getting Started
This chapter describes the interfaces that you use to configure, administer, and maintain Cisco Finesse and
describes how to access them.
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Administration Tools

Cisco Finesse Administration Console

The Cisco Finesse administration console is a web-based interface used to configure system settings in Cisco
Finesse. The administration console contains tabs that you click to access the various administration features.
The tab names and the tasks that you can perform on each tab are as follows:

• Settings: IP Phone Agent Settings.

• Call Variables Layout:Manage the call variables and ECC variables that appear on the agent desktop
call control gadget.

• Desktop Layout:Make changes to the default desktop layout for agents and supervisors.

• Phone Books: Add, edit, or delete phone books or phone book contacts.

• Reasons: Add, edit, or delete Not Ready reason codes, Sign Out reason codes, or Wrap-Up reasons.

• Team Resources: Assign desktop layouts, phone books, reason codes, and wrap-up reasons to specific
teams.

• Workflows: Create and manage workflows and workflow actions.

The features you configure in the administration console are case-sensitive. For example, you can create two
workflows named WORKFLOW and workflow or two phone books named BOOK and book.

Sign In to Cisco Finesse Administration Console

You can access the Cisco Finesse administration console only through HTTPS.

When you sign in to Finesse, always use the fully qualified domain name (FQDN) of the Finesse server in
the URL, not the server IP address or hostname.

Procedure

Step 1 Direct your browser to https://FQDN:8445/cfadmin, where FQDN is the fully qualified domain name of your
primary server.

Step 2 The first time you access the administration console using HTTPS, you are prompted to trust the self-signed
certificate provided with Finesse. The following table describes the steps for each supported browser.

If you are using HTTP to access the administration console, this step is not required.

If you are using HTTPS but have installed a CA Certificate, you can skip this step. For more
information about installing a CA Certificate, see the .

Note

DescriptionOption

If you use Internet
Explorer:

1. A page appears that states there is a problemwith the website's security certificate.
Click Continue to this website (not recommended). This action opens the sign
in page for the administration console. A certificate error appears in the address
bar of your browser.

2. Click Certificate Error, and then click View Certificates to open the Certificate
dialog box.
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DescriptionOption

3. In the Certificate dialog box, click Install Certificate. This action opens the
Certificate Import Wizard.

4. Click Next.

5. Select Place all certificates in the following store, and then click Browse.

6. Select Trusted Root Certification Authorities, and then click OK.

7. Click Next.

8. Click Finish.

9. If a Security Warning dialog box appears that asks if you want to install the
certificate, click Yes.

A Certificate Import dialog box appears that states the import was successful.

10. Click OK.

If you use Firefox: 1. A page appears that states this connection is untrusted.

2. Click I Understand the Risks, and then click Add Exception.

3. In the Add Security Exception dialog box, ensure the Permanently store this
exception check box is checked.

4. Click Confirm Security Exception.

Step 3 On the Sign-In page, in the ID field, enter the Application User ID that was established during the installation.
Step 4 In the Password field, enter the Application User password that was established during the installation.
Step 5 Click Sign In.

A successful sign-in launches an interface with defined administration gadgets and a Sign Out link.

After 30 minutes of inactivity, Finesse automatically signs you out of the administration console and you must
sign in again.

Note

Account Locked After Five Failed Sign In Attempts

If an administrator tries to sign in to the Finesse administrator console (or diagnostic portal) with the wrong
password five times in a row, Finesse blocks access to that user account for a period up to 30 minutes. For
security reasons, Finesse does not alert the user that their account is locked. They must wait 30 minutes and
try again.

Similarly, if agents or supervisors sign in to the desktop five times in a row with the wrong password, Finesse
blocks access to that user account. However, in this case, the lockout period is only 5 minutes. This restriction
also applies when agents and supervisors sign in using the mobile agent or Finesse IP Phone Agent (IPPA).
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When an agent or supervisor account is locked, subsequent attempts to sign in, even with correct credentials,
reset the lockout period to 5 minutes again. For example, if a locked user tries to sign in again after only 4
minutes, the lockout period is reset and the user must wait another 5 minutes. This reset does not apply to the
administrator account.

Note

To view whether a user account is locked, enter the following CLI command:

file get activelog desktop recurs compress

Then extract the zipped output, and search the catalina.out logs (/opt/cisco/desktop/finesse/logs/catalina.out)
for the following message referring to the locked username:

An attempt was made to authenticate the locked user "<username>"

Manage System Settings

For information about Finesse IP Phone Agent Settings, seeManage Finesse IP Phone Agent.Note

Related Topics
Manage Finesse IP Phone Agent, on page 62

Context Service Settings
Cisco Context Service is a cloud-based omnichannel solution for Cisco Unified Contact Center Express. It
enables you to capture your customer’s interaction history by providing flexible storage of customer-interaction
data across any channel.

Context Service works out of the box with Cisco Customer Collaboration products. Context Service also
provides an SDK interface for integration with your own applications or third-party applications to capture
end-to-end customer-interaction data.

For more information about Context Service and to check service availability, see https://help.webex.com/
community/context-service.

Context Service Network Connectivity Requirements

Context Service is a cloud-based service and requires that call center components using Context Service to
be able to connect to the public Internet.

Context Service uses port 443 (HTTPS).

The following URLs must be whitelisted in your firewall so that your contact center components can connect
to, and receive data from Context Service.

• *.webex.com

• *.wbx2.com

• *.ciscoccservice.com
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Use wildcard URLs in your allowed list because Context Service is accessed through multiple subdomains.
Context Service subdomain names can dynamically change.

Note

If you register Context Service by enabling the proxy setting option, configure the browser proxy with the
URL specified in the Context Service Management Gadget.

Register and Configure Context Service

Registering applications with Context Service is easy if your Cisco Webex Control Hub account has been
entitled for Context Service.

For Cisco Context Center on-premise applications, simply use the built-in registration process. A browser
window displays and prompts you to log in to Cisco Webex Control Hub. Log in and follow the on-screen
instructions to authorize the application to connect to Context Service.

Use the Context Service Management gadget to register Unified CCX with the Context Service.

Before you begin

Ensure that your web browser allows popups.

When your organization is entitled for Cisco Context Service, you must have received an email requesting a
sign-in and a password change. Sign in using the registration email, and change the password. Now your
organization is entitled to use Context Service.

If the browser requires a proxy to connect to internet, configure the browser to use proxy. See the browser
documentation about configuring proxy.

Procedure

Step 1 Verify the Context Service parameters as specified on the System Parameters Configuration Web Page.
If Unified CCX server has to access Context Service via HTTP proxy, configure the proxy parameters and
select proxy type as HTTP .

Step 2 If you are not already signed in, sign in to the Cisco Finesse Administration console.
Step 3 To register Unified CCX with the Context Service, in the Context Service Management gadget, click

Register. For more information about Context Service registration, see https://help.webex.com/community/
context-service.

If the Unified CCX FQDN is not added as an exception in the blocked popup window settings of
the browser, the opened registration and deregistration popup windows do not close automatically.
You must manually close the popup windows.

Note

Step 4 You are prompted to log in and enter your Cisco Webex Control Hub admin credentials to complete the
registration.

If you encounter any issues with the Context Service connectivity and would want to reregister or
troubleshoot the issue, click Deregister.

Note

During the Registration process, at any time if you wish to cancel the registration, clickCancel. If registration
fails or context service cannot be reached, you can reregister by clicking the Register button.
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In case of Context Service failures, you will receive RTMT alerts.

If using Firefox, enable the dom.allow_scripts_to_close_windows config to ensure that any
additional tabs opened for context service registration close as expected. To do this:

1. Enter about:config in the Firefox browser.

2. Click I accept the risk.

3. Search for dom.allow_scripts_to_close_windows config.

4. Double click to change the value field to True.

5. Restart your browser.

Note

What to do next

If context service registration is done by enabling the proxy setting option, configure the browser proxy with
the URL specified in the Context Service Management gadget.

Manage Call Variables Layouts

Call Variables Layouts
You can use the Call Variables Layouts gadget to define how call variables appear on the Finesse agent
desktop. You can configure up to 200 unique Call Variables Layouts (one default layout and 199 custom
layouts). As part of this functionality:

• Each layout has a name (required) and description (optional).

• After an upgrade from a release earlier than Cisco Finesse Release 11.0, Finesse migrates the previously
configured default layout and assigns it the default name (Default Layout) and description (Layout used
when no other layout matches the user layout Custom/ECC Variable).

• You can change the name and description of the default Call Variables Layout.

• You cannot delete the default Call Variables Layout.

• Finesse appends (Default) to the name of the default Call Variables Layout.

• To display a custom Call Variables Layout, in the Unified CCX routing script set the user.layout ECC
variable to the name of a configured Call Variables Layout. In this case, if no custom layouts match the
user.layout value (or no custom layouts are configured), Finesse displays the default layout.

• Finesse retains the custom layout as specified by the user.Layout ECC variable on CTI server failover.
During PG failover, Finesse changes the active call layout to the default layout while retaining the call
variables and time indicators.
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Call Variables
Each Call Variables Layout supports one variable in the header of the call control gadget and up to a total of
20 variables in two columns below the header (up to 10 in each column). You can use call variables, Extended
Call Context (ECC) variables, or the following Outbound Option ECC variables.

• BACampaign

• BAAccountNumber

• BAResponse

• BAStatus

• BADialedListID

• BATimeZone

• BABuddyName

• BACustomerNumber

Columns can be empty.

To enable Outbound Option data to appear in Cisco Finesse, the administrator must edit the Default layout
to include some or all Outbound Option variables.

Configure Call Variables Layouts

Procedure

Step 1 From the Manage Call Variables Layouts gadget:

• To create a new Call Variables Layout, click New.

• To modify an existing Call Variables Layout, choose a layout from the list, and clickEdit (or clickDelete
to remove it).

Step 2 Under Create New Layout (or under Edit <layout name> when editing an existing layout):

• Enter a name for the Call Variables Layout (maximum 40 characters).

• Enter a description of the Call Variables Layout (maximum 128 characters).
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Step 3 Under Call Header Layout:

• Enter the display name that you want to appear in the header of the Call Control gadget on the Finesse
desktop, for example, Customer Name (maximum 50 characters).

• From the drop-down list, choose the call variable or Outbound Option ECC variable that you want to
appear in the header, for example, callVariable3 (maximum 32 characters).

Step 4 In the Call Body Left-Hand Layout and Call Body Right-Hand Layout areas:
a) Click Add Row to add a new row (or click the “X” to delete a row).
b) For each row:

• Enter the display name that you want to appear on the desktop, for example, Customer Name
(maximum 50 characters).

• Enter the corresponding call variable or Outbound Option ECC variable from the drop-down list
(maximum 32 characters).

Step 5 Click Save to save the changes, or Cancel to discard the changes.

When you modify the Call Variables Layout of the agent desktop, the changes you make take effect
after three seconds. However, agents who are signed in when the changes are made must sign out
and sign back in to see those changes reflected on their desktops.

Note

Step 6 To view the latest configured Call Variables Layout, click Refresh from the Manage Call Variables Layouts
gadget.
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Add ECC Variables to Call Variables Layout

Cisco Finesse only supports Latin1 characters for ECC variables. Other Unicode characters are not supported.
For example, if you add an ECC variable that contains Chinese characters to the call variable layout, it may
not appear correctly on the agent desktop.

Note

Procedure

Step 1 In the header or the row where you want the ECC variable to appear, from the Variable drop-down list, choose
Custom.

The Custom/ECC Variable Entry dialog box appears.

Step 2 In the Custom/ECC Variable Name field, enter the name of the ECC variable you want to appear on the agent
desktop.

Step 3 Click Set.

The ECC variable now appears in the Variable drop-down list for selection.

Assign Call Variables Layouts

Procedure

Step 1 In the CCX Editor's Expanded Call Variables tab, create an ECC variable called user.layout in the Set
Enterprise Call Info Step used in the CCX routing script.

If both a user.layout and a user.Layout are specified, Finesse will prioritize user.layout over
user.Layout. If the layout specified in the user.Layout or user.layout is not found, Finesse will use
the Default layout.

Note
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Step 2 Set the value of user.layout to the name of the call variables layout that should be used. The layout name
should match the name of a call variables layout that was created on the Call Variables Layout tab in Finesse
Administration.

Manipulate Call Variables Layouts with a Workflow
You can manipulate the call variables layout that an agent sees when a call is answered by using a workflow.
To do so, configure an HTTP Request workflow action and set the value of the ECC variable user. Layout to
the name of the custom layout to display.

For information about how and when workflows are executed, seeWorkflows and Workflow Actions.

For more details, see the section, "Adding an HTTP Request Workflow Action" in the white paper Cisco
Finesse: How to Create a Screen-Pop Workflow.

Related Topics
Workflows and Workflow Actions, on page 49

Manage Desktop Layout
You can define the layout of the Finesse desktop on the Desktop Layout tab.

Requirements, such as processor speed and RAM, for clients that access the Finesse desktop can vary. Desktops
that receive events for more than one agent (such as agent and supervisor desktops running Live Data reports
that contain information about other agents and skill groups) require more processing power than desktops
that receive events for a single agent.

Factors that determine howmuch power is required for the client include, but are not limited to, the following:

• Contact center traffic

• Additional integrated gadgets in the desktop (such as Live Data reports or third-party gadgets)

• Other applications that run on the client and share resources with the Finesse desktop

Important

Finesse Desktop Layout XML
The Finesse Layout XML defines the layout of the Finesse desktop, including tab names and the gadgets that
appear on each tab.

Use the Manage Desktop Layout gadget to upload an XML layout file to define the layout of the Finesse
desktop for agents and supervisors.

Actions on the Manage Desktop Layout gadget:

• Finesse Default Layout XML: Expands to show the layout XML for the default Finesse desktop.

• Restore Default Layout: Restores the Finesse desktop to the default layout.

• Save: Saves your configuration changes.

• Revert: Retrieves and applies the most recently saved desktop layout.
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Default Layout XML
The Finesse default desktop layout XML for Unified CCX contains optional tabs and gadgets forMediaSense,
Web Chat and Email, and notes that describe how to modify the layout for your deployment type.

Remove the comments from the optional gadgets and tabs that you want to appear on the Finesse desktop.

Remove any gadgets or tabs that you do not want to use.

Line breaks and spaces that appear in the following text are provided only for readability and must not be
included in the actual code.

Note

<finesseLayout xmlns="http://www.cisco.com/vtg/finesse">
<layout>

<role>Agent</role>
<page>

<gadget>/desktop/gadgets/CallControl.jsp</gadget>
<!--

The following Gadget is used for WebChat and Email. It is *ONLY* supported with
WebChat and Email. If you are not using WebChat and Email, then remove it. If you
are using WebChat or Email, include this Gadget in the Desktop Layouts used by
Teams associated with chat and email CSQs. To include this functionality:

1) Remove these comments leaving the gadget

RESTRICTIONS:
- The NonVoiceControl gadget must be configured as a page level gadget
- The NonVoiceControl gadget must not be configured in a column

<gadget>https://localhost/agentdesktop/gadgets/NonVoiceControl.xml</gadget>
-->

</page>
<tabs>

<tab>
<id>home</id>
<label>finesse.container.tabs.agent.homeLabel</label>
<columns>

<column>
<gadgets>

<gadget>https://localhost:8444/cuic/gadget/
LiveData/LiveDataGadget.jsp?gadgetHeight=310&
viewId=76D964AD10000140000000830A4E5E6F&
filterId=AgentCSQStats.csqName=CL&compositeFilterId=
AgentCSQStats.AgentIds.agentId=loginId</gadget>
<gadget>https://localhost:8444/cuic/gadget/
LiveData/LiveDataGadget.jsp?gadgetHeight=310&
viewId=5C626F9C10000140000000600A4E5B33&
filterId=ResourceIAQStats.resourceId=CL</gadget>

</gadgets>
</column>

</columns>
</tab>
<tab>

<id>myStatistics</id>
<label>finesse.container.tabs.agent.myStatisticsLabel</label>
<columns>

<column>
<gadgets>

<gadget>https://localhost:8444/cuic/gadget/
LiveData/LiveDataGadget.jsp?gadgetHeight=150&
viewId=67D4371110000140000001080A4E5E6B&
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filterId=ResourceIAQStats.resourceId=loginId</gadget>
<gadget>https://localhost:8444/cuic/gadget/
LiveData/LiveDataGadget.jsp?gadgetHeight=420&
viewId=5D411E8A10000140000000230A4E5E6B&
filterId=AgentStateDetailStats.agentID=loginId</gadget>

</gadgets>
</column>

</columns>
</tab>
<tab>

<id>manageCustomer</id>
<label>finesse.container.tabs.agent.manageCustomerLabel</label>
<gadgets>

<gadget>/desktop/gadgets/CustomerContext.xml</gadget>
</gadgets>

</tab>
<!--

The following Tab and Gadget are used for WebChat and Email. They are *ONLY*
supported with WebChat and Email. If you are not using WebChat or Email, then remove
them. If you are using WebChat or Email, include this Gadget in the Desktop Layouts
used by Teams associated with chat or email CSQs. To include this functionality:

1) Remove these comments leaving the tab and gadget
2) Replace all instances of "my-socialminer-server" with the Fully Qualified

Domain Name of your SocialMiner Server.
3) [OPTIONAL] Adjust the height of the gadget by changing the "gadgetHeight"

parameter.

IMPORTANT NOTE:
- In order for this Gadget to work, you must have performed all documented
prerequisite steps.

RESTRICTIONS:
- The multisession-reply-gadget must not be configured as a page level gadget
- The multisession-reply-gadget must not be configured in a column

<tab>
<id>manageNonVoiceMedia</id>
<label>finesse.container.tabs.agent.manageNonVoiceMediaLabel</label>
<columns>

<column>
<gadgets>

<gadget>https://my-socialminer-server/multisession/ui/
gadgets/multisession-reply-gadget.jsp?gadgetHeight=430
</gadget>

</gadgets>
</column>

</columns>
</tab>

-->
</tabs>

</layout>
<layout>

<role>Supervisor</role>
<page>

<gadget>/desktop/gadgets/CallControl.jsp</gadget>
<!--

The following Gadget is used for WebChat and Email. It is *ONLY* supported with
WebChat and Email. If you are not using WebChat and Email, then remove it. If
you are using WebChat or Email, include this Gadget in the Desktop Layouts used
by Teams associated with chat or email CSQs. To include this functionality:

1) Remove these comments leaving the gadget

RESTRICTIONS:
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- The NonVoiceControl gadget must be configured as a page level gadget
- The NonVoiceControl gadget must not be configured in a column

<gadget>https://localhost/agentdesktop/gadgets/NonVoiceControl.xml</gadget>
-->
<!--

Set the height of the TeamPerformance gadget using the "maxRows" parameter. If you
do not set or if you set the height to less than 10 rows, then default value is
applied. The default value is 10. for eg. <gadget>/desktop/gadgets/
TeamPerformance.jsp?maxRows=20</gadget>

-->
</page>
<tabs>

<tab>
<id>manageTeam</id>
<label>finesse.container.tabs.supervisor.manageTeamLabel</label>
<columns>

<column>
<gadgets>

<gadget>/desktop/gadgets/TeamPerformance.jsp</gadget>
</gadgets>

</column>
</columns>

</tab>
<tab>

<id>teamData</id>
<label>finesse.container.tabs.supervisor.teamDataLabel</label>
<columns>

<column>
<gadgets>

<gadget>https://localhost:8444/cuic/gadget/
LiveData/LiveDataGadget.jsp?gadgetHeight=620&
viewId_1=7291DCB410000140000000890A4E5B33&
filterId_1=ResourceIAQStats.resourceId=CL&
viewId_2=728283C210000140000000530A4E5B33&
filterId_2=ResourceIAQStats.resourceId=CL</gadget>

<!--
The following Gadget is used for WebChat and Email. It is *ONLY* supported with
WebChat and Email. If you are not using WebChat or Email, then remove it. If you
are using WebChat or Email, include this Gadget in the Desktop Layouts used by
Teams associated with chat or email CSQs. To include this functionality:

1) Remove these comments leaving the gadget

<gadget>https://localhost:8444/cuic/gadget/
LiveData/LiveDataGadget.jsp?gadgetHeight=310&
viewId=F2F1FC17100001440000014E0A4E5D48&
filterId=ChatAgentStats.agentId=CL</gadget>
<gadget>https://localhost:8444/cuic/gadget/
LiveData/LiveDataGadget.jsp?gadgetHeight=310&
viewId=BCC5767B1000014F000000580A4D3FA7&
filterId=EmailAgentStats.agentId=CL</gadget>

-->
<!--

The following Gadgets are used for Predictive/Progressive/Preview Agent Outbound.
To include this functionality:
1) Remove these comments leaving the gadget

<gadget>https://localhost:8444/cuic/gadget/
LiveData/LiveDataGadget.jsp?gadgetHeight=310&
viewId=FD919FB9100001440000005D0A4E5B29&
filterId=ResourceIAQStats.resourceId=CL</gadget>
<gadget>https://localhost:8444/cuic/gadget/
LiveData/LiveDataGadget.jsp?gadgetHeight=310&
viewId=FD919FB510000144000000470A4E5B29&
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filterId=ResourceIAQStats.resourceId=CL</gadget>
-->

</gadgets>
</column>

</columns>
</tab>
<tab>

<id>queueData</id>
<label>finesse.container.tabs.supervisor.queueDataLabel</label>
<columns>

<column>
<gadgets>

<gadget>https://localhost:8444/cuic/gadget/
LiveData/LiveDataGadget.jsp?gadgetHeight=620&
viewId_1=C8E2DB1610000140000000A60A4E5E6B&
filterId_1=VoiceIAQStats.esdName=CL&
viewId_2=9A7A14CE10000140000000ED0A4E5E6B&
filterId_2=VoiceCSQDetailsStats.agentId=CL&
compositeFilterId=VoiceCSQDetailsStats.
AgentVoiceCSQNames.agentVoiceCSQName=CL&
viewId_3=C8EF510810000140000000EB0A4E5E6B&
filterId_3=VoiceIAQStats.esdName=CL&
viewId_4=C8EE241910000140000000C30A4E5E6B&
filterId_4=VoiceIAQStats.esdName=CL</gadget>

<!--
The following Gadget is used for WebChat and Email. It is *ONLY* supported with WebChat

and Email. If
you are not using WebChat or Email, then remove it. If you are using WebChat or Email,

include this
Gadget in the Desktop Layouts used by Teams associated with chat or email CSQs. To

include
this functionality:

1) Remove these comments leaving the gadget

<gadget>https://localhost:8444/cuic/gadget/LiveData/
LiveDataGadget.jsp?gadgetHeight=310&
viewId=E42ED788100001440000007B0A4E5CA1&
filterId=ChatQueueStatistics.queueName=CL</gadget>
<gadget>https://localhost:8444/cuic/gadget/LiveData/
LiveDataGadget.jsp? gadgetHeight=310&
viewId=13970B4E100001500000021C0A4D3FA7&
filterId=EmailQueueStatistics.queueName=CL</gadget>

-->
</gadgets>

</column>
</columns>

</tab>
<tab>

<id>manageCustomer</id>
<label>finesse.container.tabs.supervisor.manageCustomerLabel</label>
<gadgets>

<gadget>/desktop/gadgets/CustomerContext.xml</gadget>
</gadgets>

</tab>
<!--

The following Tab and Gadget are used for WebChat and Email. They are *ONLY*
supported with WebChat and Email. If you are not using WebChat or Email, then remove
them. If you are using WebChat or Email, include this Gadget in the Desktop Layouts
used by Teams associated with chat or email CSQs. To include this functionality:

1) Remove these comments leaving the tab and gadget
2) Replace all instances of "my-socialminer-server" with the Fully Qualified

Domain Name of your SocialMiner Server.
3) [OPTIONAL] Adjust the height of the gadget by changing the "gadgetHeight"

parameter.
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IMPORTANT NOTE:
- In order for this Gadget to work, you must have performed all documented
prerequisite steps.

RESTRICTIONS:
- The multisession-reply-gadget must not be configured as a page level gadget
- The multisession-reply-gadget must not be configured in a column

<tab>
<id>manageNonVoiceMedia</id>
<label>finesse.container.tabs.supervisor.manageNonVoiceMediaLabel</label>
<columns>

<column>
<gadgets>

<gadget>https://my-socialminer-server/multisession/ui/
gadgets/multisession-reply-gadget.jsp?gadgetHeight=430
</gadget>

</gadgets>
</column>

</columns>
</tab>

-->
<!--

The following Tab and Gadget are for MediaSense. They are *ONLY* supported with
MediaSense. If you are not using MediaSense, then remove them. If you are using
MediaSense and wish to show Recording Management, then do the following:

1) Remove these comments leaving the tab and gadget
2) Replace all instances of "my-mediasense-server" with the Fully Qualified

Domain Name of your MediaSense Server.

IMPORTANT NOTE:
- In order for this Gadget to work, you must have performed all documented
prerequisite steps.

<tab>
<id>manageRecordings</id>
<label>finesse.container.tabs.supervisor.manageRecordingsLabel</label>
<columns>

<column>
<gadgets>

<gadget>https://my-mediasense-server:8440/ora/gadget/
MediaSenseGadget.xml</gadget>

</gadgets>
</column>

</columns>
</tab>

-->
</tabs>

</layout>
</finesseLayout>
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After a system upgrade, the old desktop layout is retained. If you had a modified desktop layout before upgrade,
perform the following steps to ensure you obtain the latest changes:

• Sign in to the Finesse administration console and click the Desktop Layout tab.

• Copy the desktop layout to a text file.

• On the Manage Desktop Layout gadget, click Restore Default Layout.

• Click Save.

• Using the text file of the desktop layout that you saved before the upgrade as a reference, modify the
layout to include the changes that you made to the previous layout.

• Click Save to save your changes.

Important

Update Default Desktop Layout
When you modify the layout of the Finesse desktop, the changes you make take effect on the desktop after
10 seconds. However, agents who are signed in when the changes are made must sign out and sign back in
to see those changes reflected on the desktop.

The call control gadget is only supported at the page level. You must ensure that the call control gadget
(<gadget>/desktop/gadgets/CallControl.jsp</gadget>) is placed within the <page></page> tag for it to work
correctly. Do not place this gadget within a <tab></tab> tag.

Note

Procedure

Step 1 In the Finesse Layout XML area, make changes to the XML as required.

Example:

If you want to add a new tab called Reports, add the following XML within the tabs tags under the
<role>Agent</role> tag.

<tab>
<id>reports</id>
<label>Reports</label>
</tab>

If you want to add this tab to the supervisor desktop, add the XML within the tabs tags under the
<role>Supervisor</role> tag.

To add a gadget to a tab, add the XML for the gadget within the gadgets tag for that tab.

<gadgets>
<gadget>http://<ipAddress>/gadgets/<gadgetname>.xml</gadget>

</gadgets>
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Replace <ipAddress> with the IP address of the server where the gadget resides.

If you want to add multiple columns to a tab on the Finesse desktop, add the gadgets for each column within
the columns tags for that tab. You can have up to four columns on a tab.

<tab>
<id>tab-id</id>
<label>Tab Label</label>
<columns>

<column>
<gadgets>

<gadget>/gadget/1/url.xml</gadget>
<gadget>/gadget/2/url.xml</gadget>

</gadgets>
</column>
<column>

<gadgets>
<gadget>/gadget/3/url.xml</gadget>
<gadget>/gadget/4/url.xml</gadget>

</gadgets>
</column>

</columns>
</tab>

Step 2 Click Save.

Finesse validates the XML file to ensure that it is valid XML syntax and conforms to the Finesse schema.

Step 3 After you save your changes, if you want to revert to the last saved desktop layout, click Revert. If you want
to revert to the default desktop layout, click Restore Default Layout.

During upgrade, any changes made to the Cisco Finesse Default Layout will be not be updated.
You need to click on Restore Default Layout to get the latest changes.

Note

XML Schema Definition
Youmust ensure the XML you upload conforms to the XML schema definition for Finesse. The XML schema
definition for Finesse is as follows:

<?xml version="1.0" encoding="ISO-8859-1" ?>
<xs:schema xmlns:xs="http://www.w3.org/2001/XMLSchema"

targetNamespace="http://www.cisco.com/vtg/finesse"
xmlns="http://www.cisco.com/vtg/finesse"
elementFormDefault="qualified">

<!-- definition of role type -->
<xs:simpleType name="role">
<xs:restriction base="xs:string">

<xs:enumeration value="Agent"/>
<xs:enumeration value="Supervisor"/>
<xs:enumeration value="Admin"/>

</xs:restriction>
</xs:simpleType>

<!-- definition of simple elements -->
<xs:element name="id">
<xs:simpleType>
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<xs:restriction base="xs:string">
<xs:pattern value="[a-zA-Z]([-_:\.a-zA-Z0-9])*"/>

</xs:restriction>
</xs:simpleType>

</xs:element>

<xs:element name="label">
<xs:simpleType>

<xs:restriction base="xs:string">
<xs:minLength value="1" />

</xs:restriction>
</xs:simpleType>

</xs:element>

<xs:element name="gadget">
<xs:simpleType>

<xs:restriction base="xs:anyURI">
<xs:minLength value="1" />

</xs:restriction>
</xs:simpleType>

</xs:element>
<xs:element name="role" type="role"/>

<xs:element name="gadgets"> <!-- Grouping of a set of gadgets -->
<xs:complexType>

<xs:sequence maxOccurs="unbounded">
<!-- No limit to number of gadget URIs for now -->
<xs:element ref="gadget"/> <!-- URI of the gadget xml -->
</xs:sequence>

</xs:complexType>
</xs:element>

<xs:element name="page"> <!-- Grouping of a set of persistent gadgets -->
<xs:complexType>

<xs:sequence maxOccurs="unbounded">
<!-- No limit to number of gadget URIs for now -->
<xs:element ref="gadget"/> <!-- URI of the gadget xml -->
</xs:sequence>

</xs:complexType>
</xs:element>

<xs:element name="tab">
<xs:complexType>

<xs:sequence>
<xs:element ref="id"/> <!-- Id of the tab selector in the desktop -->
<xs:element ref="label"/> <!-- Label of the tab selector -->
<xs:element ref="gadgets" minOccurs="0" maxOccurs="1"/>
</xs:sequence>

</xs:complexType>
</xs:element>

<xs:element name="tabs"> <!-- Grouping of tabs -->
<xs:complexType>

<xs:sequence maxOccurs="unbounded">
<!-- No limit to number of tabs for now -->
<xs:element ref="tab"/>
</xs:sequence>

</xs:complexType>
</xs:element>

<xs:element name="layout">
<xs:complexType>

<xs:sequence>
<xs:element ref="role"/> <!-- Type of the role -->
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<xs:element ref="page"/> <!-- List of page gadgets -->
<xs:element ref="tabs"/> <!-- Grouping of tabs for this particular role -->
</xs:sequence>

</xs:complexType>
</xs:element>

<xs:element name="finesseLayout"> <!-- Layout of the desktop -->
<xs:complexType>

<xs:sequence maxOccurs="3">
<!-- only support 3 roles for now -->
<xs:element ref="layout" />
</xs:sequence>

</xs:complexType>
</xs:element>

</xs:schema>

Add Web Chat and Email to Finesse
The Cisco Finesse default layout XML contains commented XML code for Web Chat and Email gadgets
available for the Finesse desktop. Each gadget or tab is surrounded by comment characters (<!-- and -->)
and comments that describe what the tab or gadget is for and how to add it to the desktop.

The Chat and Email Control gadget is only supported at the page level. You must ensure that the Chat and
Email Control gadget (<gadget>https://localhost/agentdesktop/gadgets/NonVoiceControl.xml</gadget>) is
placed within the <page></page> tag. Placing this gadget within a <tab></tab> tag is not supported.

Note

The procedure that you follow depends on your deployment. The following table describes when to use each
procedure.

When to useProcedure

Follow this procedure if you want to add Web Chat
and Email to the Finesse desktop after a fresh
installation or after an upgrade if you have not
customized the default desktop layout.

Add Web Chat and Email to the default desktop
layout.

Follow this procedure if you want to add Web Chat
and Email and have customized the desktop layout.

AddWeb Chat and Email to a custom desktop layout.

Follow this procedure if you want to add Web Chat
and Email to the desktop only for specific teams.

Add Web Chat and Email to a team layout.

After you add the Web Chat and Email gadgets, sign in to the Finesse desktop and make sure they appear the
way you want. Agents who are signed in to Finesse when you change the desktop layout must sign out and
sign back in to see the change on their desktops.

Note
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Add Web Chat and Email to the Default Desktop Layout

If you upgraded from a previous release but do not have a custom desktop layout, click Restore Default
Layout on the Manage Desktop Layout gadget and then follow the steps in this procedure.

Note

Procedure

Step 1 In the Finesse administration console, click the Desktop Layout tab.
Step 2 To add the Chat and Email Control gadget to the agent desktop, look for the following under the

<role>Agent</role> tag and within the <page></page> tag:
<gadget>https://localhost/agentdesktop/gadgets/NonVoiceControl.xml</gadget>

Step 3 Remove the comments and comment characters (<!-- and -->) that surround the gadget, leaving only the
gadget (<gadget>https://localhost/agentdesktop/gadgets/NonVoiceControl.xml</gadget>).

Step 4 To add the Manage Chat and Email tab and gadget to the agent desktop, look for the following within the
<tabs></tabs> tag:
<tab>

<id>manageNonVoiceMedia</id>
<label>finesse.container.tabs.agent.manageNonVoiceMediaLabel</label>
<columns>

<column>
<gadgets>

<gadget>https://my-socialminer-server/multisession/ui/gadgets/
multisession-reply-gadget.jsp?gadgetHeight=430</gadget>

</gadgets>
</column>

</columns>
</tab>

Step 5 Remove the comments and comment characters (<!-- and -->) that surround the tab.
Step 6 Replace my-socialminer-server in the gadget URL with the fully-qualified domain name (FQDN) of your

SocialMiner server.
Step 7 Optionally, change the height of the Manage Chat and Email gadget.

Example:

The height specified in the gadget URL is 430 pixels. If you want to change the height, change the gadgetHeight
parameter in the URL to the desired value. For example if you want the gadget height to be 600 pixels, change
the code as follows:
<gadget>https://my-socialminer-server/multisession/ui/gadgets/

multisession-reply-gadget.jsp?gadgetHeight=600</gadget>

The default and minimum height of the Manage Chat and Email gadget is 430 pixels. If you do not specify a
value for the gadgetHeight parameter or if you specify a value that is less than 430, the gadget defaults to 430
pixels.

An agent can be configured to handle up to five chat contacts and five email contacts at a time. If
the agent has the maximum number of contacts on the desktop, not all contacts are visible. If your
agents are configured to handle the maximum number of contacts, you must increase the height of
this gadget to a minimum of 570 pixels to ensure there is enough space for all of the contacts to
appear.

Note
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Step 8 To add the Chat and Email Control gadget to the supervisor desktop, look for the following under the
<role>Supervisor</role> tag and within the <page></page> tag:
<gadget>https://localhost/agentdesktop/gadgets/NonVoiceControl.xml</gadget>

Step 9 Remove the comments and comment characters (<!-- and -->), leaving only the gadget
(<gadget>https://localhost/agentdesktop/gadgets/NonVoiceControl.xml</gadget>).

Step 10 To add the Live Data report for Agent Chat Statistics to the supervisor desktop, look for the following:
<gadget>https://localhost:8444/cuic/gadget/LiveData/
LiveDataGadget.jsp?gadgetHeight=310&
viewId=F2F1FC17100001440000014E0A4E5D48&
filterId=ChatAgentStats.agentId=CL</gadget>

Step 11 Remove the comments and comment characters (<!-- and -->), leaving only the gadget.
Step 12 To add the Live Data report for Chat Queue Statistics to the supervisor desktop, look for the following:

<gadget>https://localhost:8444/cuic/gadget/LiveData/
LiveDataGadget.jsp?gadgetHeight=310&
viewId=E42ED788100001440000007B0A4E5CA1&
filterId=ChatQueueStatistics.queueName=CL</gadget>

Step 13 Remove the comments and comment characters (<!-- and -->), leaving only the gadget.
Step 14 To add the Manage Chat and Email tab and gadget to the supervisor desktop, look for the following within

the <tabs></tabs> tag:
<tab>

<id>manageNonVoiceMedia</id>
<label>finesse.container.tabs.supervisor.manageNonVoiceMediaLabel</label>
<columns>

<column>
<gadgets>

<gadget>https://my-socialminer-server/multisession/ui/gadgets/
multisession-reply-gadget.jsp?gadgetHeight=430</gadget>

</gadgets>
</column>

</columns>
</tab>

Step 15 Remove the comments and comment characters (<!-- and -->) that surround the tab.
Step 16 Replace my-socialminer-server in the gadget URL with the fully-qualified domain name (FQDN) of your

SocialMiner server.
Step 17 Optionally, change the height of the Manage Chat and Email gadget.
Step 18 Click Save.

Add Web Chat and Email to a Custom Desktop Layout

Procedure

Step 1 In the Finesse administration console, click the Desktop Layout tab.
Step 2 Click Finesse Default Layout XML to show the default layout XML.
Step 3 Copy the XML code for the Chat and Email Control gadget for the agent desktop.

<gadget>https://localhost/agentdesktop/gadgets/NonVoiceControl.xml</gadget>

Cisco Finesse
21

Cisco Finesse
Add Web Chat and Email to a Custom Desktop Layout



Step 4 To add the gadget to the agent desktop, paste the code within the <page></page> tags under the Call Control
gadget as follows:
<role>Agent</role>
<page>

<gadget>/desktop/gadgets/CallControl.jsp</gadget>
<gadget>https://localhost/agentdesktop/gadgets/NonVoiceControl.xml</gadget>

</page>

Step 5 To add the gadget to the supervisor desktop, paste the code within the <page></page> tags under the Call
Control gadget as follows:
<role>Supervisor</role>
<page>

<gadget>/desktop/gadgets/CallControl.jsp</gadget>
<gadget>https://localhost/agentdesktop/gadgets/NonVoiceControl.xml</gadget>

</page>

Step 6 Copy the code for the agent Manage Chat and Email tab and gadget from the default layout XML.
<tab>

<id>manageNonVoiceMedia</id>
<label>finesse.container.tabs.agent.manageNonVoiceMediaLabel</label>
<columns>

<column>
<gadgets>

<gadget>https://my-socialminer-server/multisession/ui/gadgets/
multisession-reply-gadget.jsp?gadgetHeight=430</gadget>

</gadgets>
</column>

</columns>
</tab>

Step 7 Paste the code within the <tabs></tabs> tag for the agent role after the Manage Call tab:
<tab>

<id>manageCall</id>
<label>finesse.container.tabs.agent.manageCallLabel</label>

</tab>
<tab>

<id>manageNonVoiceMedia</id>
<label>finesse.container.tabs.agent.manageNonVoiceMediaLabel</label>
<columns>

<column>
<gadgets>

<gadget>https://my-socialminer-server/multisession/ui/gadgets/
multisession-reply-gadget.jsp?gadgetHeight=430</gadget>

</gadgets>
</column>

</columns>
</tab>

Step 8 Replace my-social-miner-server with the FQDN of your SocialMiner server.
Step 9 Optionally, change the height of the Manage Chat and Email gadget.

Example:

The height specified in the gadget URL is 430 pixels. If you want to change the height, change the gadgetHeight
parameter in the URL to the desired value. For example if you want the gadget height to be 600 pixels, change
the code as follows:
<gadget>https://my-socialminer-server/multisession/ui/gadgets/

multisession-reply-gadget.jsp?gadgetHeight=600</gadget>
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The default and minimum height of the Manage Chat and Email gadget is 430 pixels. If you do not specify a
value for the gadgetHeight parameter or if you specify a value that is less than 430, the gadget defaults to 430
pixels.

An agent can be configured to handle up to five chat contacts and five email contacts at a time. If
the agent has the maximum number of contacts on the desktop, not all contacts are visible. If your
agents are configured to handle the maximum number of contacts, you must increase the height of
this gadget to a minimum of 570 pixels to ensure there is enough space for all of the contacts to
appear.

Note

Step 10 Copy the code for the Live Data gadgets for Agent Chat Statistics and Chat Queue Statistics from the default
layout XML.
<gadget>https://localhost:8444/cuic/gadget/LiveData/
LiveDataGadget.jsp?gadgetHeight=310&
viewId=F2F1FC17100001440000014E0A4E5D48&
filterId=ChatAgentStats.agentId=CL</gadget>

<gadget>https://localhost:8444/cuic/gadget/LiveData/
LiveDataGadget.jsp?gadgetHeight=310&
viewId=E42ED788100001440000007B0A4E5CA1&
filterId=ChatQueueStatistics.queueName=CL</gadget>

Step 11 Paste the code for these gadgets within the <gadgets></gadgets> tags for the tabs on which you want them
to appear.

Step 12 Copy the code for the supervisor Manage Chat and Email tab and gadget from the default layout XML.
<tab>

<id>manageNonVoiceMedia</id>
<label>finesse.container.tabs.supervisor.manageNonVoiceMediaLabel</label>
<columns>

<column>
<gadgets>

<gadget>https://my-socialminer-server/multisession/ui/gadgets/
multisession-reply-gadget.jsp?gadgetHeight=430</gadget>

</gadgets>
</column>

</columns>
</tab>

Step 13 Paste the code within the <tabs></tabs> tag for the supervisor role after the Manage Call tab:
<tab>

<id>manageCall</id>
<label>finesse.container.tabs.supervisor.manageCallLabel</label>

</tab>
<tab>

<id>manageNonVoiceMedia</id>
<label>finesse.container.tabs.supervisor.manageNonVoiceMediaLabel</label>
<columns>

<column>
<gadgets>

<gadget>https://my-socialminer-server/multisession/ui/gadgets/
multisession-reply-gadget.jsp?gadgetHeight=430</gadget>

</gadgets>
</column>

</columns>
</tab>

Step 14 Replace my-social-miner-server with the FQDN of your SocialMiner server.
Step 15 Optionally, change the height of the gadget.
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Step 16 Click Save.

Add Web Chat and Email to a Team Layout

Procedure

Step 1 In the Finesse administration console, click the Desktop Layout tab.
Step 2 Click Finesse Default Layout XML to show the default layout XML.
Step 3 Copy the XML code for the Chat and Email Control gadget for the agent desktop and paste it into a text file.

<gadget>https://localhost/agentdesktop/gadgets/NonVoiceControl.xml</gadget>

Step 4 Copy the code for the agent Manage Chat and Email tab and gadget and paste it into your text file.
<tab>

<id>manageNonVoiceMedia</id>
<label>finesse.container.tabs.agent.manageNonVoiceMediaLabel</label>
<columns>

<column>
<gadgets>

<gadget>https://my-socialminer-server/multisession/ui/gadgets/
multisession-reply-gadget.jsp?gadgetHeight=430</gadget>

</gadgets>
</column>

</columns>
</tab>

Step 5 Copy the code for the Live Data gadgets for Agent Chat Statistics and Chat Queue Statistics and paste it into
your text file.
<gadget>https://localhost:8444/cuic/gadget/LiveData/
LiveDataGadget.jsp?gadgetHeight=310&
viewId=F2F1FC17100001440000014E0A4E5D48&
filterId=ChatAgentStats.agentId=CL</gadget>

<gadget>https://localhost:8444/cuic/gadget/LiveData/
LiveDataGadget.jsp?gadgetHeight=310&
viewId=E42ED788100001440000007B0A4E5CA1&
filterId=ChatQueueStatistics.queueName=CL</gadget>

Step 6 Copy the code for the supervisor Manage Chat and Email tab and gadget and paste it into your text file.
<tab>

<id>manageNonVoiceMedia</id>
<label>finesse.container.tabs.supervisor.manageNonVoiceMediaLabel</label>
<columns>

<column>
<gadgets>

<gadget>https://my-socialminer-server/multisession/ui/gadgets/
multisession-reply-gadget.jsp?gadgetHeight=430</gadget>

</gadgets>
</column>

</columns>
</tab>

Step 7 Click the Team Resources tab.
Step 8 Select the team from the list of teams for which you want to add Web Chat and Email.
Step 9 Check the Override System Default check box.
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Step 10 In the Resources for <team name> area, click the Desktop Layout tab.
Step 11 To add the Chat and Email Control gadget to the agent desktop, copy the code for the gadget from your text

file and paste it within the <page></page> tags under the Call Control gadget as follows:
<role>Agent</role>
<page>

<gadget>/desktop/gadgets/CallControl.jsp</gadget>
<gadget>https://localhost/agentdesktop/gadgets/NonVoiceControl.xml</gadget>

</page>

Step 12 To add the gadget to the supervisor desktop, paste the code within the <page></page> tags under the Call
Control gadget as follows:
<role>Supervisor</role>
<page>

<gadget>/desktop/gadgets/CallControl.jsp</gadget>
<gadget>https://localhost/agentdesktop/gadgets/NonVoiceControl.xml</gadget>

</page>

Step 13 To add the Manage Chat and Email tab and gadget to the agent desktop, copy the code from your text file and
paste it within the <tabs></tabs> tag for the agent role after the Manage Call tab:
<tab>

<id>manageCall</id>
<label>finesse.container.tabs.agent.manageCallLabel</label>

</tab>
<tab>

<id>manageNonVoiceMedia</id>
<label>finesse.container.tabs.agent.manageNonVoiceMediaLabel</label>
<columns>

<column>
<gadgets>

<gadget>https://my-socialminer-server/multisession/ui/gadgets/
multisession-reply-gadget.jsp?gadgetHeight=430</gadget>

</gadgets>
</column>

</columns>
</tab>

Step 14 Replace my-social-miner-server with the FQDN of your SocialMiner server.
Step 15 Optionally, change the height of the Manage Chat and Email gadget.

Example:

The height specified in the gadget URL is 430 pixels. If you want to change the height, change the gadgetHeight
parameter in the URL to the desired value. For example if you want the gadget height to be 600 pixels, change
the code as follows:
<gadget>https://my-socialminer-server/multisession/ui/gadgets/

multisession-reply-gadget.jsp?gadgetHeight=600</gadget>

The default and minimum height of the Manage Chat and Email gadget is 430 pixels. If you do not specify a
value for the gadgetHeight parameter or if you specify a value that is less than 430, the gadget defaults to 430
pixels.

An agent can be configured to handle up to five chat contacts and five email contacts at a time. If
the agent has the maximum number of contacts on the desktop, not all contacts are visible. If your
agents are configured to handle the maximum number of contacts, you must increase the height of
this gadget to a minimum of 570 pixels to ensure there is enough space for all of the contacts to
appear.

Note

Cisco Finesse
25

Cisco Finesse
Add Web Chat and Email to a Team Layout



Step 16 To add the Live Data gadgets for Web Chat and Email to the supervisor desktop:
a) Copy the code for the Agent Chat Statistics Live Data gadget from your text file and paste it within the

<gadgets></gadgets> tags for the tab on which you want it to appear.
b) Copy the code for the Chat Queue Statistics Live Data gadget from your text file and paste it within the

<gadgets></gadgets> tags for the tab on which you want it to appear.

Step 17 To add the Manage Chat and Email tab gadget to the supervisor desktop, copy the code from your text file
and paste it within the <tabs></tabs> tag for the supervisor role after the Manage Call tab:
<tab>

<id>manageCall</id>
<label>finesse.container.tabs.supervisor.manageCallLabel</label>

</tab>
<tab>

<id>manageNonVoiceMedia</id>
<label>finesse.container.tabs.supervisor.manageNonVoiceMediaLabel</label>
<columns>

<column>
<gadgets>

<gadget>https://my-socialminer-server/multisession/ui/gadgets/
multisession-reply-gadget.jsp?gadgetHeight=430</gadget>

</gadgets>
</column>

</columns>
</tab>

Step 18 Replace my-social-miner-server with the FQDN of your SocialMiner server.
Step 19 Optionally, change the height of the gadget.
Step 20 Click Save.

Live Data Gadgets
Cisco Finesse for Unified CCX supports Live Data gadgets. Live Data gadgets display information about the
current state of the contact center. The gadgets receive data from the real-time data source at frequent intervals
and display reports in grid format only.

Cisco Unified Intelligence Center provides Live Data real-time reports that you can add to the Cisco Finesse
agent and supervisor desktop.

This feature provides the following access:

• Agents can access the Live Data agent reports.

• Supervisors can access the Live Data supervisor reports.

Gadgets URLs for Reports

The following table displays gadgets URLs for reports.
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Gadget URLsTabIs the
Report
Available
in
Default
Layout ?

Report ViewReportsUsers

<gadget>https://localhost:8444/cuic
/gadget/LiveData/LiveDataGadget.jsp?
gadgetHeight=310&viewId
=76D964AD10000140000000830A4E5E6F
&filterId=AgentCSQStats.csqName
=CL&compositeFilterId
=AgentCSQStats.AgentIds.agentId
=loginId</gadget>

HomeYesAgent CSQ
Statistics Report

Agent CSQ
Statistics Report

Agent

<gadget>https://localhost:8444/cuic
/gadget/LiveData/LiveDataGadget.jsp?
gadgetHeight=420&viewId
=5D411E8A10000140000000230A4E5E6B
&filterId=AgentStateDetailStats.agentID
=loginId</gadget>

My
Statistics

YesAgent State Log
Report

Agent State Log
Report

Agent

<gadget>https://localhost:8444/cuic
/gadget/LiveData/LiveDataGadget.jsp?
gadgetHeight=150&viewId
=67D4371110000140000001080A4E5E6B
&filterId=ResourceIAQStats.resourceId
=loginId</gadget>

My
Statistics

YesAgent Statistics
Report

Agent Statistics
Report

Agent

<gadget>https://localhost:8444/cuic
/gadget/LiveData/LiveDataGadget.jsp?
gadgetHeight=310&viewId
=5C626F9C10000140000000600A4E5B33
&filterId=ResourceIAQStats.
resourceId=CL</gadget>

HomeYesAgent Team
Summary Report

Agent Team
Summary Report

Agent

<gadget>https://localhost:8444/cuic
/gadget/LiveData/LiveDataGadget.jsp?
gadgetHeight=310&viewId
=FD919FB9100001440000005D0A4E5B29
&filterId=ResourceIAQStats.
resourceId=CL</gadget>

Team
Data

NoReport since
midnight

Agent Outbound
Team Summary
Report

Supervisor

<gadget>https://localhost:8444/cuic
/gadget/LiveData/LiveDataGadget.jsp?
gadgetHeight=310&viewId
=FD919FB510000144000000470A4E5B29
&filterId=ResourceIAQStats.
resourceId=CL</gadget>

Team
Data

NoShort and long
term average

Agent Outbound
Team Summary
Report

Supervisor

<gadget>https://localhost:8444/cuic
/gadget/LiveData/LiveDataGadget.jsp?
gadgetHeight=120&viewId
=F2F1FC17100001440000014E0A4E5D48
&filterId=ChatAgentStats.
agentId=CL</gadget>

Team
Data

NoChat Agent
Statistics Report

Chat Agent
Statistics Report

Supervisor
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Gadget URLsTabIs the
Report
Available
in
Default
Layout ?

Report ViewReportsUsers

<gadget>https://localhost:8444/cuic
/gadget/LiveData/LiveDataGadget.jsp?
gadgetHeight=120&viewId
=E42ED788100001440000007B0A4E5CA1
&filterId=ChatQueueStatistics.
queueName=CL</gadget>

Queue
Data

NoChat CSQ
Summary Report

Chat CSQ
Summary Report

Supervisor

<gadget>https://localhost:8444/cuic
/gadget/LiveData/LiveDataGadget.jsp?
gadgetHeight=310&viewId
=BCC5767B1000014F000000580A4D3FA7
&filterId=EmailAgentStats.
agentId=CL</gadget>

Team
Data

NoEmail Agent
Statistics Report

Email Agent
Statistics Report

Supervisor

<gadget>https://localhost:8444/cuic
/gadget/LiveData/LiveDataGadget.jsp?
gadgetHeight=310&viewId
=13970B4E100001500000021C0A4D3FA7
&filterId=EmailQueueStatistics.
queueName=CL</gadget>

Queue
Data

NoEmail CSQ
Summary Report

Email CSQ
Summary Report

Supervisor

<gadget>https://localhost:8444/cuic
/gadget/LiveData/LiveDataGadget.jsp?
gadgetHeight=310&viewId
=5C90012F10000140000000830A4E5B33
&filterId=ResourceIAQStats.
resourceId=CL</gadget>

—NoTeam State
Report

Team State
Report

Supervisor

<gadget>https://localhost:8444/cuic
/gadget/LiveData/LiveDataGadget.jsp?
gadgetHeight=310&viewId
=728283C210000140000000530A4E5B33
&filterId=ResourceIAQStats.
resourceId=CL</gadget>

Team
Data

YesReport since
midnight

Team Summary
Report

Supervisor

<gadget>https://localhost:8444/cuic
/gadget/LiveData/LiveDataGadget.jsp?
gadgetHeight=310&viewId
=7291DCB410000140000000890A4E5B33
&filterId=ResourceIAQStats.
resourceId=CL</gadget>

Team
Data

YesShort and long
term average

Team Summary
Report

Supervisor

<gadget>https://localhost:8444/cuic
/gadget/LiveData/LiveDataGadget.jsp?
gadgetHeight=310&viewId
=9A7A14CE10000140000000ED0A4E5E6B
&filterId=VoiceCSQDetailsStats.
agentId=CL&compositeFilterId
=VoiceCSQDetailsStats.AgentVoiceCSQNames.
agentVoiceCSQName=CL</gadget>

Queue
Data

YesVoice CSQ
Agent Detail
Report

Voice CSQ
Agent Detail
Report

Supervisor
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Gadget URLsTabIs the
Report
Available
in
Default
Layout ?

Report ViewReportsUsers

<gadget>https://localhost:8444/cuic
/gadget/LiveData/LiveDataGadget.jsp?
gadgetHeight=310&viewId
=C8E2DB1610000140000000A60A4E5E6B
&filterId=VoiceIAQStats.
esdName=CL</gadget>

Queue
Data

YesSnapshotVoice CSQ
Summary

Supervisor

<gadget>https://localhost:8444/cuic
/gadget/LiveData/LiveDataGadget.jsp?
gadgetHeight=310&viewId
=C8EE241910000140000000C30A4E5E6B
&filterId=VoiceIAQStats.
esdName=CL</gadget>

Queue
Data

YesShort and long
term average

Voice CSQ
Summary

Supervisor

<gadget>https://localhost:8444/cuic
/gadget/LiveData/LiveDataGadget.jsp?
gadgetHeight=310&viewId
=C8EF510810000140000000EB0A4E5E6B
&filterId=VoiceIAQStats.
esdName=CL</gadget>

Queue
Data

NoReport since
midnight

Voice CSQ
Summary

Supervisor

Gadgets Customization

You can use optional query parameter to adjust height of the gadgets.

Query Parameter

<gadget>https://localhost:8444/cuic/gadget/LiveData/LiveDataGadget.jsp?
gadgetHeight=200&viewId=5C626F9C10000140000000600A4E5B33&filterId=ResourceIAQStats.resourceId=CL</gadget>

Add Live Data Gadgets to Desktop Layout

The Cisco Finesse default layout XML contains commented XML code for the Live Data gadgets available
for Cisco Finesse desktop. Perform the following steps to add Live Data gadgets to desktop layout:

Procedure

Step 1 Sign in to Cisco Finesse administration console.
Cisco Finesse home page appears.

Step 2 Click the Desktop Layout tab.
Step 3 Click Finesse Default Layout XML to show the default layout XML.
Step 4 Copy the gadget URL for the report you want to add from Live Data Gadgets.

Example:

To add the Agent Report, copy the following:
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<gadget>https://localhost:8444/cuic/gadget/LiveData/LiveDataGadget.jsp?gadgetHeight
=150&viewId=67D4371110000140000001080A4E5E6B&filterId=ResourceIAQStats.resourceId=loginId</gadget>

Step 5 Paste the gadget URL within the tab tags where you want it to appear.

Example:

To add the report to the home tab of the agent desktop:
<finesseLayout xmlns="http://www.cisco.com/vtg/finesse">
<layout>
<role>Agent</role>
<page>
<gadget>/desktop/gadgets/CallControl.jsp</gadget>
</page>
<tabs>
<tab>
<id>home</id>
<label>finesse.container.tabs.agent.homeLabel</label>
<gadgets>
<gadget>https://localhost:8444/cuic/gadget/LiveData/LiveDataGadget.jsp?gadgetHeight
=310&viewId=76D964AD10000140000000830A4E5E6F&filterId=AgentCSQStats.csqName
=CL&compositeFilterId=AgentCSQStats.AgentIds.agentId=loginId</gadget>
<gadget>https://localhost:8444/cuic/gadget/LiveData/LiveDataGadget.jsp?gadgetHeight
=310&viewId=5C626F9C10000140000000600A4E5B33&filterId
=ResourceIAQStats.resourceId=CL</gadget>
</gadgets>
<gadget>https://localhost:8444/cuic/gadget/LiveData/LiveDataGadget.jsp?gadgetHeight
=150&viewId=67D4371110000140000001080A4E5E6B&filterId=ResourceIAQStats.resourceId
=loginId</gadget>

</tab>
<tab>
<id>myStatistics</id>
<label>finesse.container.tabs.agent.myStatisticsLabel</label>
<gadgets>
<gadget>https://localhost:8444/cuic/gadget/LiveData/LiveDataGadget.jsp?gadgetHeight
=600&viewId=5D411E8A10000140000000230A4E5E6B&filterId=AgentStateDetailStats.agentID
=loginId</gadget>
</gadgets>
</tab>
<tab>
<id>manageCall</id>
<label>finesse.container.tabs.agent.manageCallLabel</label>
</tab>
</tabs>
</layout>
<layout>
<role>Supervisor</role>
<page>
<gadget>/desktop/gadgets/CallControl.jsp</gadget>
</page>

Step 6 Click Save. Cisco Finesse validates the XML file to ensure that it is valid XML syntax and conforms to the
Cisco Finesse schema.

Step 7 To verify, log in to Cisco Finesse agent desktop as agent/Cisco Finesse supervisor desktop as supervisor and
check the reports.

Related Topics
Live Data Gadgets, on page 26
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Add Customized Live Data Gadgets to Desktop Layout

This procedure explains how to create gadget URLs for customized Live Data reports, which are copied from
stock reports, and add them to desktop layout.

The new gadget renders the report only when the appropriate permission on that report is given in Cisco
Unified Intelligence Center.

Note

Procedure

Step 1 Copy the gadget URL of the stock report that you want to customize from Live Data Gadgets and paste it in
a text editor.

Example:

Consider the URL shown here as the gadget URL. Copy and paste it in a text editor. The underlined ID is the
value of viewID.
<gadget>https://localhost:8444/cuic/gadget/LiveData/LiveDataGadget.jsp?gadgetHeight=310
&viewId=5C626F9C10000140000000600A4E5B33&filterId=ResourceIAQStats.resourceId=CL</gadget>

Step 2 In Cisco Unified Intelligence Center, in the Edit view of the customized report, select the view for which you
want to create the gadget URL and then click Links.
The HTML Link field displays the permalink of the customized report.

Step 3 Copy the permalink of the customized report from the HTML Link field and paste it in a text editor, then
copy the viewID value from this link.

Example:

Copy the underlined viewID value from the permalink of the customized report.
https://<Server Name>:8444/cuic/permalink/PermalinkViewer.htmx?
viewId=5C90012F10000140000000830A4E5B33&linkType=htmlType&viewType=Grid

Step 4 Replace the viewID value in the gadget URL with the viewID value from the permalink of the customized
report.

Example:

The customized gadget URL appears as shown here after replacing the viewID value with the viewID value
of the customized report.

<gadget>https://localhost:8444/cuic/gadget/LiveData/LiveDataGadget.jsp?gadgetHeight=310
&viewId=5C90012F10000140000000830A4E5B33&filterId=ResourceIAQStats.resourceId=CL</gadget>

Step 5 Add the customized gadget URL to Desktop Layout in the Finesse administration console and save.
Step 6 Log in to Finesse desktop and check the report.

Related Topics
Live Data Gadgets, on page 26
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Live Data Reports
Cisco Unified Intelligence Center provides Live Data real-time reports that you can add to the Finesse desktop.

Configure Live Data Reports with Multiple Views

Cisco Finesse allows you to display multiple Live Data reports or views on a single gadget. Supervisors can
select the desired view to display from a drop-down list on the gadget toolbar, which lists up to five report
views in Report Name - View Name format.

This procedure describes how to addmultiple Live Data views to the Finesse desktop layout using the viewId_n
and filterId_n keys. You can specify up to five report views to appear in your gadget. The first view among
the five is the default view. There is no defined order for how the remaining views are displayed.

Finesse still supports the display of a single gadget using a single viewId. However, if you specify the single
viewId along with multiple viewId_n keys, the multiple views are used and the single viewId is ignored.

To make sure the modified gadget renders in the Finesse desktop, you must give the appropriate permission
for that report in Unified Intelligence Center.

Note

Procedure

Step 1 For each report or view that you want to include in the gadget, obtain the associated viewId from the permalink
for the view:
a) In Unified Intelligence Center, in Edit view of the report, select the desired view then click Links.

The HTML Link field displays the permalink of the customized report.

b) Copy the permalink of the customized report from theHTMLLink field, and paste it in a text editor, and
then copy the viewID value from the permalink and save it.

Example:

Copy the viewId, which is underlined in this example, from the permalink for the report.

https://<Server Name>:8444/cuic/permalink/PermalinkViewer.htmx?
viewId=5C90012F10000140000000830A4E5B33&linkType=htmlType&viewType=Grid

Step 2 From the Finesse default layout XML, copy the gadget URL for one of the Live Data reports and paste it into
a text editor.

Example:

Copy the URL for the Agent Skill Group for HTTPS from the default layout XML and paste it into a text
editor:

<gadget>https://my-cuic-server:8444/cuic/gadget/LiveData/LiveDataGadget.jsp?gadgetHeight=310&
viewId_1=9AB7848B10000141000001C50A0006C4&filterId_1=agent.id=CL%20teamName</gadget>

Step 3 To update the URL to refer to a different report view, populate the viewId_1 value (after the equal sign) with
the desired viewId obtained in step 1.
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Example:

The following shows the URL updated with the example viewId copied from step 1.

<gadget>https://my-cuic-server:8444/cuic/gadget/LiveData/LiveDataGadget.jsp?gadgetHeight=310&
viewId_1=5C90012F10000140000000830A4E5B33&filterId_1=agent.id=CL%20teamName</gadget>

Step 4 For each additional view you want to include:
a) At the end of the URL, copy and paste the viewId_1 and agentId_1 strings with a leading ampersand.

Example:

<gadget>https://my-cuic-server:8444/cuic/gadget/LiveData/LiveDataGadget.jsp?gadgetHeight=310&
viewId_1=5C90012F10000140000000830A4E5B33&filterId_1=agent.id=CL%20teamName&
viewId_1=5C90012F10000140000000830A4E5B33&filterId_1=agent.id=CL%20teamName</gadget>

b) Update the copied viewId_1 and filterId_1 in the URL to the next available integer (in this example,
viewId_2 and filterId_2).

Example:

<gadget>https://my-cuic-server:8444/cuic/gadget/LiveData/LiveDataGadget.jsp?gadgetHeight=310&
viewId_1=5C90012F10000140000000830A4E5B33&filterId_1=agent.id=CL%20teamName&
viewId_2=5C90012F10000140000000830A4E5B33&filterId_2=agent.id=CL%20teamName</gadget>

c) Populate the copied viewId value (after the equal sign) with the value defined in the permalink for the
desired report (in this example, 99E6C8E210000141000000D80A0006C4).

Example:

<gadget>https://my-cuic-server:8444/cuic/gadget/LiveData/LiveDataGadget.jsp?gadgetHeight=310&
viewId_1=5C90012F10000140000000830A4E5B33&filterId_1=agent.id=CL%20teamName&
viewId_2=99E6C8E210000141000000D80A0006C4&filterId_2=agent.id=CL%20teamName</gadget>

d) Make sure that the filterId value matches the type required by the report type, as follows:

• Agent Reports: filterId_N=agent.id=CL%20teamName

• Agent Skill Group Reports: filterId_N=agent.id=CL%20teamName

• Skill Group Reports: filterId_N=skillGroup.id=CL%20teamName

• Precision Queue Reports: filterId_N=precisionQueue.id=CL%20teamName

Step 5 Replace my-cuic-server with the fully qualified domain name of your Cisco Unified Intelligence Center Server.
Step 6 Add the customized gadget URL to the desktop layout XML in the Manage Desktop Layout gadget and click

Save.

After you add the gadget, sign in to the Finesse desktop and make sure it appears the way you want.
If you use a report with a large number of rows, you may want to adjust the gadget height or the
screen resolution on the computer used to access the desktop to make the report easier to read or
make more rows appear on the screen without the need to scroll.

Agents who are signed in when you change the desktop layout must sign out and sign back in to
see the change on their desktops.

Note
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Manage Phone Books
On the Phone Books tab of the Cisco Finesse administration console, you can create and manage global and
team phone books and phone book contacts. Global phone books are available to all agents; team phone books
are available to agents in that specific team.

Phone Books and Contacts
Finesse supports the following number of phone books:

• 10 global phone books

• 300 team phone books

The system supports a total of 50,000 contacts. The total number of contacts per agent across all phone books
is limited to 1500.

Use theManage Phone Books gadget to view, add, edit, or delete phone books and phone book contacts. Click
the Name or Assign To headers to sort the phone books in ascending or descending order. Click the last Name,
First Name, Number, or Note headers to sort the contacts in ascending or descending order.

The following table describes the fields on the Manage Phone Books gadget.

ExplanationField

The name of the phone book. The name must be unique, and can be a maximum
length of 64 alphanumeric characters.

Name

Indicates if the phone book is global (All Users) or team (Teams).Assign To

The last name of a contact. The last name can be a maximum length of 128
characters. This field is optional.

Last Name

The first name of a contact. The first name can be a maximum length of 128
characters. This field is optional.

First Name

The phone number for the contact. The phone number can be 1-32 characters long
and cannot be blank.

Number

Optional text that describes the contact. The note can be a maximum length of
128 characters.

Note

Actions on the Manage Phone Books gadget:

• New: Add a new phone book or contact

• Edit: Edit an existing phone book or contact

• Delete: Delete a phone book or contact

• Refresh: Reload the list of phone books or contacts from the server

• Import: Import a list of contacts to the phone book

• Export: Export a list of contacts from the phone book
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Add Phone Book

Procedure

Step 1 In the Manage Phone Books gadget, click New.

The Manage Phone Books area appears.

Step 2 In the Name box, enter a name for the phone book.

Phone book names can be a maximum length of 64 characters.Note

Step 3 In the Assign To box drop-down list, select All Users if the phone book is global or Teams if the phone book
is available to specified teams.

Step 4 Click Save.

Edit Phone Book

Procedure

Step 1 In the Manage Phone Books gadget, select the phone book you want to edit.
Step 2 Click Edit.

The Edit Phone Books area appears.

Step 3 In the Name field, enter the new name for the phone book. If you want to change who can access the phone
book, in the Assign To field drop-down list, choose All Users or Teams.

Step 4 Click Save.

If you change the Assign To field from Teams to All Users, a message appears that asks you to confirm the
change. Click Yes to confirm.

Delete Phone Book

Procedure

Step 1 In the Manage Phone Books gadget, select the phone book that you want to delete.
Step 2 Click Delete.

A question appears asking you to confirm that you want to delete the selected phone book.

Step 3 Click Yes to confirm the deletion of the selected phone book.
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Import Contacts
The Import function allows you to replace all the contacts in a phone book with a new list of contacts, or to
populate a new phone book with contacts.

The import list must be in the specified comma separated values (CSV) format, and can contain a maximum
of 1500 contacts. Import lists that contain more than 1500 contacts are rejected with an error message.

The CSV file contains the fields described in the following table.

Permitted CharactersCan Be
Blank?

Max
Length

Field

Alphanumeric characters

The CSV file that contains the contacts to import must use
Latin encoding.

Note

Yes128First Name

Yes128Last Name

No32Phone
Number

Yes128Notes

The following is an example of a phone book CSV file:
"First Name","Last Name","Phone Number","Notes"
"Amanda","Cohen","6511234",""
"Nicholas","Knight","612-555-1228","Sales"
"Natalie","Lambert","952-555-9876","Benefits"
"Joseph","Stonetree","651-555-7612","Manager"

A phone book CSV file must conform to this format and include the headers in the first line. During import,
the file is scanned for illegal characters. If any are found, they are replaced with question marks.

Exported CSV files always show each field enclosed in double quotes, as in the preceding example, to ensure
that any commas or double quotes that are part of the actual filed data are not mistaken for field delimiters.
If your data does not include these characters, you can omit the double quotes in files you prepare for importing.

Note

Procedure

Step 1 In the Manage Phone Books gadget, select the phone book into which you want to import a list of contacts.
Step 2 Click Import.

The Import Contacts area appears.

Step 3 Click Browse and navigate to the location of the CSV file containing the contacts you want to import.

The CSV file must use Latin encoding.Note

Step 4 Click OK.
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Export Contacts
The Export function allows you to extract a list of contacts from an existing phone book. The exported list is
saved in CSV format.

Procedure

Step 1 In the Manage Phone Books gadget, select the phone book that contains the contacts you want to export.
Step 2 Click Export.

A message is displayed asking if you want to open or save the file.

The default name for an export file is PhoneBookContacts.csv.Note

Step 3 Click Open to open the CSV file in Excel, or click the Save drop-down list and choose Save, Save as, or
Save and open, as desired.

Step 4 A message appears that gives you the option to view the downloaded file, open the folder into which the
download was saved, view the Internet Explorer View Downloads window, or dismiss the message without
viewing the file.

Add Contact

Procedure

Step 1 In the Manage Phone Books gadget, select the phone book to which you want to add a contact.

The List of Contacts for <phone book name> area appears.

Step 2 Click New.

The New Contact area appears.

Step 3 Complete the fields. The First Name, Last Name, and Note fields are optional and have a maximum length
of 128 characters. The Number field is required and has a maximum length of 32 characters.

Step 4 Click Save.

Edit Contact

Procedure

Step 1 In the Manage Phone Books gadget, select the phone book that contains the contact you want to edit.

The List of Contacts for <phone book name> area appears.

Step 2 Select the contact you want to edit.
Step 3 Click Edit.
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The Edit Contact area appears.

Step 4 Edit the fields that you want to change. The First Name, Last Name, and Note fields are optional and have a
maximum length of 128 characters. The Number field is required and has a maximum length of 32 characters.

Step 5 Click Save.

Delete Contact

Procedure

Step 1 In the Manage Phone Books gadget, select the phone book that contains the contact you want to delete.

The List of Contacts for <phone book name> area appears.

Step 2 Select the contact that you want to delete.
Step 3 Click Delete.

A question appears asking you to confirm that you want to delete the selected contact.

Step 4 Click Yes to confirm the deletion of the selected contact.

Manage Reasons
The Reasons tab on the Cisco Finesse administration console allows you to view, add, edit, and delete Not
Ready reason codes, Sign Out reason codes, and Wrap-Up reasons.

Certain reason codes are reserved and cannot be used.

For Unified CCX systems, these reserved reason codes are as follows: 0, 22, and 33.

Note

Not Ready Reason Codes
Not Ready reason codes represent reasons that agents can select when they change their state to Not Ready.

Use the Manage Reason Codes (Not Ready) gadget to view, add, edit, or delete Not Ready reason codes.
Click the Reason Label or Reason Code headers to sort the Not Ready reason codes by label or reason code
in ascending or descending order. Click the Global header to sort reason codes by whether they are global
(Yes) or not (No).

Not Ready reason codes can be global (visible to all agents) or team (visible only to agents on specified teams).

Finesse supports a total of 200 Not Ready reason codes. This includes a maximum of 100 global Not Ready
reason codes, and 100 Not Ready team reason codes. The team reason codes can be mapped to any team, and
the same reason code can be mapped to multiple teams.

Note
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The following table describes the fields on the Manage Reason Codes (Not Ready) gadget.

ExplanationField

The label for the Not Ready reason code.Reason Label

The label has a maximum length of 40 characters and should be unique for each
Not Ready reason code. Both alphanumeric and special characters are supported.

A code for the Not Ready reason.Reason Code

The value of the code must be between 1 and 999 and must be unique.

Yes/No. Indicates if the reason code is available globally to all agents (Yes) or to
specific teams of agents (No).

Global?

In previous releases, Finesse did allow you to create multiple Not Ready reason codes with the same code or
with code values greater than 999. If you upgraded from a previous release, you may have Not Ready reason
codes in your database that violate the new rules. After you complete the upgrade, find the codes and edit
them to give them unique values within the supported range. You can find the codes by clicking on the Reason
Code header to sort the codes by their value.

Note

Actions on the Manage Reason Codes (Not Ready) gadget:

• New: Add a new Not Ready reason code

• Edit: Edit an existing Not Ready reason code

• Delete: Delete a Not Ready reason code

• Refresh: Reload the list of Not Ready reason codes from the server

When you add, edit, or delete a Not Ready reason code, the changes you make take effect on the Finesse
desktop after three seconds. However, agents who are signed in when the changes are made must sign out
and sign back in to see those changes reflected on their desktops.

Note

When an agent signs in to the Finesse desktop, the agent state is set to Not Ready. The agent can then choose
to go to Ready status or choose from one of the configured Not Ready reason codes from the agent state
drop-down list.

If an agent wants to change from Ready to Not Ready status, that agent can choose the appropriate Not Ready
reason code from the list of configured codes.

An agent who is on a call can select a state to be applied when the call is complete. For example, if an agent
wants to be in Not Ready state when the call ends, that agent can choose Not Ready from the drop-down list
while still on the call. The Finesse desktop shows the agent in Talking state and a pending state of Not Ready.

Pending state changes appear on the desktop while the agent's state is Talking (for example, on hold, in a
consult call, conference, or silent monitor call).
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Add Not Ready Reason Code

Perform the following procedure to add a new Not Ready reason code.

Procedure

Step 1 In the Manage Reason Codes (Not Ready) gadget, click New.

The New Reason Code area appears.

Step 2 In the Reason Label box, enter a label for the reason code.

Not Ready reason code labels are limited to 40 characters.Note

Step 3 In the Reason Code box, enter a reason code.

The code must be between 1 and 999 and must be unique.

Ensure there are no leading or trailing spaces.

Note

Step 4 If the reason code is global, select the Global? check box. If the reason code is specific to a team, clear the
Global? check box.

By default, the Global? check box is selected.Note

Step 5 Click Save.

The Finesse server removes leading or trailing spaces before saving the Reason Label in the database.Note

Edit Not Ready Reason Code

Perform the following procedure to edit the label or code for an existing Not Ready reason code.

Procedure

Step 1 In the Manage Reason Codes (Not Ready) gadget, select the reason code that you want to edit.
Step 2 Click Edit.

The Edit Reason Code area appears.

Step 3 If you want to change the label for the Not Ready reason code, in the Reason Label field, enter a new label
for the reason code. If you want to change the code, in the Reason Code field, enter the new code. If you want
to change who has access to the code, select or clear the Global? check box.

Step 4 Click Save.
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Delete Not Ready Reason Code

An error may occur if an agent selects a Not Ready reason code after it has been deleted. Agents who are
signed in when you make changes to Not Ready reason codes must sign out and sign back in to see those
changes reflected on their desktops.

Note

Perform the following procedure to delete a Not Ready reason code.

Procedure

Step 1 In the Manage Reason Codes (Not Ready) gadget, select the Not Ready reason code that you want to delete.
Step 2 Click Delete.

A question appears asking you to confirm that you want to delete the selected reason code.

Step 3 Click Yes to confirm the deletion of the selected reason code.

Sign Out Reason Codes
Sign Out reason codes represent reasons that agents can select when they sign out of the Finesse desktop.

Use the Manage Reason Codes (Sign Out) gadget to view, add, edit, or delete Sign Out reason codes. Click
the Reason Label or Reason Code headers to sort the Sign Out reason codes by label or by reason code, in
ascending or descending order. Click the Global header to sort the reason codes by whether they are global
(Yes) or not (No).

Sign Out reason codes can be global (visible to all agents) or team (visible only to agents on specified teams).

Finesse supports a total of 200 Sign Out reason codes. This includes a maximum of 100 global Sign Out
reason codes, and 100 Sign Out team reason codes. The team reason codes can be mapped to any team, and
the same reason code can be mapped to multiple teams.

Note

The following table describes the fields on the Manage Reason Codes (Sign Out) gadget.

ExplanationField

The label for the Sign Out reason code.Reason Label

The label has a maximum length of 40 characters and should be unique for each
Sign Out reason code. Both alphanumeric and special characters are supported.

A code for the Sign Out reason.Reason Code

The code must be between 1 and 999 and must be unique.

Yes/No. Indicates if the reason code is available globally to all agents (Yes) or
to specific teams of agents (No).

Global?
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In previous releases, Finesse did allow you to create multiple Sign Out reason codes with the same code or
with code values greater than 999. If you upgraded from a previous release, you may have Sign Out reason
codes in your database that violate the new rules. After you complete the upgrade, find the codes and edit
them to give them unique values within the supported range. You can find the codes by clicking on the Reason
Code header to sort the codes by their value.

Note

Actions on the Manage Reason Codes (Sign Out) gadget:

• New: Add a new Sign Out reason code

• Edit: Edit an existing Sign Out reason code

• Delete: Delete a Sign Out reason code

• Refresh: Reload the list of Sign Out reason codes from the server

When you add, edit, or delete a Sign Out reason code, the changes youmake take effect on the Finesse desktop
after three seconds. However, agents who are signed in when the changes are made must sign out and sign
back in to see those changes reflected on their desktops.

Note

When an agent clicks Sign Out on the desktop, any configured Sign Out codes appear in a drop-down list.
The agent can then choose the code that represents why that agent is signing out.

Add Sign Out Reason Code

Perform the following procedure to add a new Sign Out reason code.

Procedure

Step 1 In the Manage Reason Codes (Sign Out) gadget, click New.

The New Reason Code area appears.

Step 2 In the Reason Label box, enter a label for the reason code.

Sign Out reason code labels are limited to 40 characters.Note

Step 3 In the Reason Code box, enter a reason code.

The code must be between 1 and 999 and must be unique.

Ensure there are no leading or trailing spaces.

Note

Step 4 If the reason code is global, select the Global? check box. If the reason code is specific to a team, clear the
Global? check box.

By default, the Global? check box is selected.Note
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Step 5 Click Save.

Edit Sign Out Reason Code

Perform the following procedure to edit the label or code for an existing Sign Out reason code.

Procedure

Step 1 In the Manage Reason Codes (Sign Out) gadget, select the reason code that you want to edit.
Step 2 Click Edit.

The Edit Reason Code area appears.

Step 3 If you want to change the label of the Sign Out reason code, in the Reason Label field, enter a new label for
the reason code. If you want to change the code, in the Reason Code field, enter the new code. If you want to
change who has access to the code, select or clear the Global? check box.

Step 4 Click Save.

Delete Sign Out Reason Code

An error may occur if an agent selects a Sign Out reason code after it has been deleted. Agents who are signed
in when you make changes to Sign Out reason codes must sign out and sign back in to see those changes
reflected on their desktops.

Note

Perform the following procedure to delete a Sign Out reason code.

Procedure

Step 1 In the Manage Reason Codes (Sign Out) gadget, select the Sign Out reason code that you want to delete.
Step 2 Click Delete.

A question appears asking you to confirm that you want to delete the selected reason code.

Step 3 Click Yes to confirm the deletion of the selected Sign Out reason code.

Wrap-Up Reasons
Wrap-Up reasons represent the reasons that agents can apply to calls. A Wrap-Up reason indicates why a
customer called the contact center. For example, youmay have oneWrap-Up reason for sales calls and another
for support calls.

You can configure Wrap-Up reasons to be available globally to all agents or only to specific teams.

Use the Manage Wrap-Up Reasons gadget to view, add, edit, or delete Wrap-Up reasons. Click the Reason
Label header to sort the Wrap-Up reasons in ascending or descending order.
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Finesse supports a maximum of 100 global and 1500 team Wrap-Up reasons. No more than 100 Wrap-Up
reasons can be assigned to any one team.

Note

If an agent is configured for wrap-up and selects a pending state during a call, when the call finishes that agent
goes into the pending state selected during the call.

Note

The following table describes the fields on the Manage Wrap-Up Reasons gadget.

ExplanationField

The label for the Wrap-Up reason.Reason Label

This label must be unique for each Wrap-Up reason and has a maximum length of
39 bytes (which equals 39 US English characters). Both alphanumeric and special
characters are supported.

Yes/No. Indicates if the Wrap-Up reason is available globally to all agents (Yes)
or to specific teams of agents (No).

Global?

Actions on the Manage Wrap-Up Reasons gadget:

• New: Add a new Wrap-Up reason

• Edit: Edit an existing Wrap-Up reason

• Delete: Delete a Wrap-Up reason

• Refresh: Reload the list of Wrap-Up reasons from the server

When you add, edit, or delete a Wrap-Up reason, the changes you make take effect on the agent or supervisor
desktop after three seconds. However, agents who are signed in when the changes are made must sign out
and sign back in to see those changes reflected on their desktops.

Note

Add Wrap-Up Reason

Perform the following procedure to add a new Wrap-Up reason.

Procedure

Step 1 In the Manage Wrap-Up Reasons gadget, click New.

The New Wrap-Up Reason area appears.

Step 2 In the Reason Label field, add a label for the Wrap-Up reason.

Wrap-Up reason labels are limited to 39 bytes.Note
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Step 3 If the Wrap-Up reason is global, select the Global? check box. If the Wrap-Up reason is specific to a team,
clear the Global? check box.

By default, the Global? check box is selected.Note

Step 4 Click Save.

Edit Wrap-Up Reason

Perform the following procedure to edit an existing Wrap-Up reason.

Procedure

Step 1 In the Manage Wrap-Up Reasons gadget, select the Wrap-Up reason that you want to edit.
Step 2 Click Edit.

The Edit Wrap-Up Reason area appears.

Step 3 In the Wrap-Up Reason Label field, enter the new label for the Wrap-Up reason. If you want to change who
has access to the Wrap-Up reason, select or clear the Global? check box.

Step 4 Click Save.

Delete Wrap-Up Reason

Perform the following procedure to delete a Wrap-Up reason.

Procedure

Step 1 In the Manage Wrap-Up Reasons gadget, select the Wrap-Up reason that you want to delete.
Step 2 Click Delete.

A question appears asking you to confirm that you want to delete the selected Wrap-Up reason.

Step 3 Click Yes to confirm the deletion of the selected Wrap-Up reason.

Manage Team Resources
You can assign phone books, reason codes, wrap-up reasons, custom desktop layouts, and workflows to teams
on the Team Resources tab of the administration console.

Team Resources
Use the Manage Team Resources gadget on the Team Resources tab to assign and unassign phone books,
reasons, custom desktop layouts, and workflows to teams. Click the Name or ID header to sort the teams in
ascending or descending order.
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The Manage Team Resources gadget contains six tabs, each enabling you to assign or unassign resources to
a team. The tabs are defined in the following table.

DescriptionTab Name

Use this tab to customize the desktop layout for the team. The default layout is defined
in the Manage Desktop Layout gadget. You can define one custom layout for the
team.

Desktop Layout

Use this tab to assign and unassign phone books to the team. Only phone books that
are defined in the Manage Phone Books gadget as available to teams are available
for assignment.

Phone Books

Use this tab to assign and unassign Not Ready reason codes to the team. Only Not
Ready reason codes that are defined in theManage Reason Codes (Not Ready) gadget
as available to teams (not global) are available for assignment.

Reason Codes (Not
Ready)

Use this tab to assign and unassign Sign Out reason codes to the team. Only Sign
Out reason codes that are defined in the Manage Reason Codes (Sign Out) gadget
as available to teams (not global) are available for assignment.

Reason Codes (Sign
Out)

Use this tab to assign and unassign Wrap-Up reasons to the team. Only Wrap-Up
reasons that are defined in the Manage Wrap-Up Reasons gadget as available to
teams (not global) are available for assignment.

Wrap-Up Reasons

Use this tab to assign and unassign workflows to the team. Only workflows that are
defined in the Manage Workflows gadget are available for assignment.

Workflows

Actions on the Manage Team Resources Gadget

• Add: Assign a phone book, reason, or workflow to the team

• Save: Save the phone book, reason, desktop layout assignment, or workflow to the team

• Revert: Cancel any changes made before they are saved
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• Refresh: Refresh the list of teams

If you select a team and then click Refresh, the team is deselected and the
Resources area for that team disappears. The list of teams is refreshed and you
must select a team again.

Note

Add or Delete a Team When Database Is Not Accessible

If you add or delete a team when Finesse cannot access the Finesse database, those changes do not appear in
the Finesse administration console unless you restart Cisco Finesse Tomcat or the Cisco Unified CCXEngine.

Assign Phone Books and Reasons to Team

Procedure

Step 1 In the Manage Team Resources gadget, select a team.

Tabs for each available resource appear.

Step 2 Click the tab for the resource you want to assign for the selected team.

The List of <resource> area appears.

Step 3 Click Add.

The Add <resource> popup appears.

Step 4 Select one or more resources from the list to assign them to the team.

Resources you assign are highlighted in blue in the Add <resources> popup and added to the List of <resources>
area.

Step 5 When you has finished assigning resources, click Save.

You can make changes on all resource tabs and then save them at the same time. If there is an error
on one resource tab but not others, the changes on the tabs with no errors are saved while the changes
on the tab with errors are not saved.

Note

Unassign Phone Books and Reasons from Team

Procedure

Step 1 In the Manage Team Resources gadget, select a team.

Tabs for each available resource appear.

Step 2 Click the tab for the resource you want to unassign from the selected team.
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The List of <resource> area appears.

Step 3 Click the red X next to the resource you want to unassign.
Step 4 Click Save.

Assign Custom Desktop Layout to Team
Perform the following procedure to create and assign a custom desktop layout to a team.

Procedure

Step 1 In the Manage Team Resources gadget, select a team.

Tabs for each available resource appear.

Step 2 Click the Desktop Layout tab.

The Desktop Layout XML area appears. The area contains the default desktop layout XML.

Step 3 Select the Override System Default check box.

The XML becomes editable.

Step 4 Edit the XML as desired.
Step 5 Click Save.

The custom desktop layout replaces the default desktop layout for the team after 10 seconds. If a supervisor
or agent is signed in when the change is saved, the change does not go into effect on their desktop until the
supervisor or agent signs out and signs in again.

If you clear the Override System Default check box, any changes you made to the XML are lost
and the XML in the editing pane reverts to the default desktop layout XML.

Note

If the Supervisor is managing single / multiple teams, the custom layout of the team for which he is a resource
/ agent is displayed. However, if he is not a resource / agent of the team, the layout of the default team is
displayed.

Note

Assign Workflows to Team

Procedure

Step 1 In the Manage Team Resources gadget, select a team.

Tabs for each available resource appear.

Step 2 Click the Workflows tab.
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The List of Workflows area appears.

Step 3 Click Add.

The Add Workflow popup appears.

Step 4 Select one or more workflows from the list to assign them to the team.

Workflows you assign are highlighted in blue in the AddWorkflows popup and added to the List ofWorkflows
area.

Step 5 Workflows are executed in the order in which they are listed. Use the up and down arrows to move a selected
workflow to the desired position in the list.

Step 6 When you has finished assigning workflows, click Save.

You can make changes on all resource tabs and then save them at the same time. If there is an error
on one resource tab but not others, the changes on the tabs with no errors are saved while the changes
on the tab with errors are not saved.

Note

Unassign Workflows from Team

Procedure

Step 1 In the Manage Team Resources gadget, select a team.

Tabs for each available resource appear.

Step 2 Click the Workflows tab.

The List of Workflows area appears.

Step 3 Click the red X next to the workflow you want to unassign.
Step 4 Click Save.

Manage Workflows
On the Workflows tab of the Cisco Finesse administration console, you can create and manage workflows
and workflow actions.

Workflows and Workflow Actions
You can use workflows to automate common repetitive agent tasks. A workflow has a unique name and a
helpful description. Use the Manage Workflows and Manage Workflow Actions gadgets to view, add, edit,
or delete workflows and workflow actions.

All workflows are team-level workflows. You cannot create a global workflow. If you need a global workflow,
create a team workflow and assign it to all teams.

Finesse supports the following number of workflows and workflow actions:
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• 100 workflows per Finesse system

• 100 actions per Finesse system

• 20 workflows per team

• 5 conditions per workflow

• 5 actions per workflow

• 5 variables per action

Click the column headers to sort workflows and workflow actions in ascending or descending order.

The following table describes the fields on the Manage Workflows gadget.

ExplanationField

The name of the workflow. The name must be unique and can be a maximum
length of 40 characters.

Name

The description of the workflow. The description can be a maximum length of
128 characters.

Description

The following table describes the fields on the Manage Workflow Actions gadget.

ExplanationField

The name of the workflow action. The namemust be unique and can be amaximum
length of 64 characters.

Name

The type of workflow. Possible values are Browser Pop, HTTP Request.Type

Actions on the Manage Workflows and Manage Workflow Actions gadgets:

• New: Add a new workflow or workflow action

• Edit: Edit an workflow or workflow action

• Delete: Delete a workflow or workflow action

• Refresh: Reload the list of workflows or workflow actions from the server

You can configure workflow actions to be handled by the Finesse desktop or in a third-party gadget. A
third-party gadget can be designed to handle the action differently than Finesse does.

Each workflow must contain only one trigger. Triggers are based on Finesse dialog events. Dialog events
include the following:

• When a call arrives

• When a call is answered

If you set a workflow to trigger when a call is answered, the workflow runs when
an agent answers an incoming call or makes an outgoing call, or when a customer
answers an Outbound Option call.

Note
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• When a call ends

• When making a call

• While previewing a Direct Preview Outbound call.

The workflow engine uses the following simple logic to determine whether to execute a workflow:

• To determine whether a workflow should execute, its trigger set and conditions are evaluated against
each dialog event received.

• The workflow engine processes workflow events for the first call that matches any configured workflow's
trigger set and conditions. No other workflows run until this call has ended. If the agent accepts a second
call while still on the first call, workflows do not run on the second call even after the first call has ended.

Outbound Preview calls are an exception to this rule. You can have a workflow
run while the agent previews the call as well as when the agent accepts the call.

Note

• After a workflow for a particular trigger type (for example, Call Arrives) executes, it never triggers again
for the same dialog ID.

The workflow engine caches workflows for an agent when the agent signs in. Workflows do not change for
the agent until the agent signs out and signs in again or refreshes the browser.

Workflows that trigger when a call arrives, when a call is answered, or when making a call run whenever the
browser is refreshed. When an agent refreshes the browser, the workflow engine sees the call as newly arrived
or newly made. If an HTTP request action is part of the workflow, the HTTP request is sent when the agent
refreshes the browser. Applications that receive the HTTP requests must account for this scenario. Otherwise,
undesired results may occur.

Note

An example of a workflow is a Call Arrival event that triggers an action that collects information from the
dialog event (for example, the ANI or customer information) and displays a web page containing customer
information.

You can filter trigger events by the value of the data that comes in the event. You can configure a workflow
to execute if any conditions are met or if all conditions are met.

Individual conditions consist of the following:

• A piece of event data to be examined, for example, DNIS or call variables

• A comparison between the event data and entered values (for example, contains, is equal to, is not equal
to, begins with, ends with, is empty, is not empty, and is in list)

When the trigger and its conditions are satisfied, a list of actions assigned to the workflow are executed. The
actions execute in the order in which they are listed.

Workflows run only for agents and supervisors who are Finesse users. The Workflow Engine is a JavaScript
library that runs client-side on a per-user basis within the Finesse desktop application. The desktop retrieves
the workflows to execute for a user from the server when the user signs in or refreshes the browser.
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Changes made to a workflow or its actions while a user is signed in are not automatically pushed to that user.Note

It is possible to set workflows, conditions, and actions that are contradictory so that a workflow or action
cannot function. Workflows are not validated.

If multiple workflows are configured for a team, theWorkflow Engine evaluates them in the configured order.
TheWorkflow Engine ignores workflows with no actions. When theWorkflow Engine finds a workflow with
a matching trigger for the event and the workflow conditions evaluate to true, then that workflow is the one
used and subsequent workflows in the list are not evaluated. Workflows with no conditions evaluate to true
if the event matches the workflow trigger. All workflows are enabled by default. Only one workflow for a
specific user can run at a time.

The Workflow Engine retrieves dialog-based variables used in workflow conditions from the dialog that
triggered the workflow. If a variable is not found in the dialog, then its value is assumed to be empty.

The Workflow Engine executes the actions associated with the matched workflow in the order in which they
are listed. The Workflow Engine executes actions in a workflow even if the previously executed action fails.
Failed actions are logged.

The Finesse server controls which calls are displayed to the Finesse user. If the user has multiple calls, the
workflow applies only to the first call that matches a trigger. If the first call displayed does not match any
triggers but the second call does match a trigger, the Workflow Engine evaluates and processes the triggers
for the second call.

A call is considered to be the first displayed call if it is the only call on the Finesse desktop when it appears.
If two calls on a phone are merged (as they are in a conference call), then the first displayed call flag value
of the surviving call is used.

If the user has a call when the user refreshes the browser, the Workflow Engine evaluates the call as it is. If
the dialog data (call variable values) change, the data may not match the trigger and conditions of the original
workflow. The data may match a different workflow or no workflows at all.

If the user has multiple calls when the user refreshes the browser, the Workflow Engine treats the first dialog
received from the Finesse server as the first displayed call. This call is not necessarily the same call that was
the first displayed call before the browser refresh. Dialogs received for any other call are ignored because
they are not considered first displayed calls. If dialogs for more than one call are received before theWorkflow
Engine is loaded after the browser refresh, no dialogs are evaluated because none are considered first displayed
calls.

Workflows run for both Finesse agents and supervisors. The team to which the supervisor belongs (as
distinguished from the team that the supervisor manages) determines which workflows run for the supervisor.
You may want to put the supervisors in their own team to keep agent workflows from being run for them.

Workflow Triggers and Outbound Calls

When you create a workflow specifically for Outbound Option calls, add a condition of BAStatus is not empty
(except for the Workflow Trigger 'When a call arrives' as BAStatus will be empty at that point of time). This
condition ensures that the workflow can distinguish Outbound Option calls from agent-initiated outbound
calls.

Note

The following table illustrates when workflows trigger in outbound call scenarios.
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Progressive or Predictive Outbound
Call

Direct Preview Outbound CallWorkflow Trigger

Does not trigger.When the agent previews the call
(before the agent accepts or rejects
the call).

While previewing a call

Does not trigger.When the agent accepts the call.When a call arrives

When the customer answers the
call.

If the agent conferences in another
agent or transfers the call, the
workflow triggers for the agent
who is the recipient of the
conference or transfer.

When the customer answers the
call.

If the agent conferences in another
agent or transfers the call, the
workflow triggers for the agent
who is the recipient of the
conference or transfer.

When a call is answered

When the customer call is initiated
or when failover occurs during the
call.

When the customer call is
initiated.

When a call is made

When the customer call ends.When the customer call ends.When a call ends

Add Browser Pop Workflow Action
The Browser Pop workflow action opens a browser window or tab on the user's desktop when workflow
conditions are met.

Whether the action opens a new window or tab on the desktop depends on the target user's browser settings.Note

Procedure

Step 1 In the Manage Workflow Actions gadget, click New.

The New Action area appears.

Step 2 In the Name box, enter a name for the action.

Workflow action names are limited to 64 characters.Note

Step 3 From the Type drop-down list, select Browser Pop.
Step 4 From the Handled By drop-down list, select what will execute the action, either the Finesse Desktop or Other

(a third-party gadget).
Step 5 In the Window Name box, enter the name that serves as the ID of the window that is opened. Any action that

uses this window name reuses that specific window.

Window names are limited to 40 characters, and can be blank. If you leave the window name blank,
a new window opens every time the action runs.

Note
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Step 6 Enter the URL of the browser window to open, and then click the tag icon at the right of the box and select
one or more variables from the drop-down list to add tags.

Example:

For every variable you select, you can enter test data in the Sample Data box. A sample URL is automatically
built in the Browser URL box below the Sample Data area. To test the URL, click Open to open the URL in
your browser.

Finesse does not validate the URL you enter.Note

Step 7 Click Save.

Add HTTP Request Workflow Action
The HTTP Request workflow action makes an HTTP request to an API on behalf of the desktop user.

Procedure

Step 1 In the Manage Workflow Actions area, click New.

The New Action area appears.

Step 2 In the Name box, enter a name for the action.

A workflow action name can contain a maximum of 64 characters.

Step 3 From the Type drop-down list, select HTTP Request.
Step 4 From the Handled By drop-down list, select what will execute the action, the Finesse desktop or Other (a

third-party gadget).
Step 5 From the Method drop-down list, select the method to use.

You can select either PUT or POST.

Step 6 From the Location drop-down list, select the location.

If you are making the HTTP request to a Finesse API, select Finesse. If you are making a request to any other
API, select Other.

Step 7 In the Content Type box, enter the content type.

The default content type is application/xml, which is the content type for Finesse APIs. If you are using a
different API, enter the content types for that API (for example, application/JSON).

Step 8 In the URL box, enter the URL to which to make the request. To add variables to the URL, click the tag icon
at the right of the box and select one or more variables from the drop-down list.

The drop-down list contains variables from all the media channels.Note

Example:
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The preceding example is the URL for a Finesse API. If you want to make a request to another API,
you must enter the entire URL (for example, http://googleapis.com).

Note

You can click the tag icon at the right of the box and select one or more variables from the drop-down list to
add tags to the URL. In the preceding example, to add the dialogId, click the tag icon and select dialogId from
the list.

Step 9 In the Body box, enter the text for the request. The body must match the content type (for example, if the
content types is application/xml, the body must contain XML. To add variables to the body, click the tag icon
at the right of the box and select one or more variables from the drop-down list.

Example:

To make an HTTP request to the Dialog - Start a recording API, enter the following into the Body box:

To add the extension, click the tag icon and select extension.

For every variable you add, you can enter test data in the Sample Data box.

Step 10 Click Save.

Edit Workflow Action

Procedure

Step 1 In the Manage Workflow Actions gadget, select the action that you want to edit.
Step 2 Click Edit.

The Edit Action area appears.

Step 3 Edit the fields that you want to change.
Step 4 Click Save.

Delete Workflow Action

Procedure

Step 1 In the Workflow Actions gadget, select the action that you want to delete.

The Delete Action area appears.
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Step 2 Click Delete.

A question appears asking you to confirm that you want to delete the selected action.

Step 3 Click Yes to confirm the deletion of the selected action.

Add Workflow

Procedure

Step 1 In the Manage Workflows gadget, click New.

The New Workflow area appears.

Step 2 In the Name box, enter the name of the workflow.

The name is limited to 40 characters.Note

Step 3 In the Description box, enter a description of the workflow.

The description is limited to 128 characters.Note

Step 4 In the When to perform Actions drop-down list, select the event that triggers the workflow.
Step 5 In the How to apply Conditions box, select if all conditions are met, or if any conditions are met, and then

click Add Condition to add up to five conditions.

Example:

For example, you can specify that the action is taken when CallVariable 1 is equal to 123 and CallVariable 2
begins with 2.

Step 6 In the Ordered List of Actions area, click Add to open the Add Actions area. Click an action in this area to
add it to the Ordered List of Actions.

Step 7 Use the up and down arrows next to the Ordered List of Actions to move actions into the order in which they
should be performed.

Step 8 Click Save.
Step 9 Assign the workflow to one or more teams.

A workflow does not run until it is assigned to a team.Note

Edit Workflow

Procedure

Step 1 In the Manage Workflows gadget, select the workflow you want to edit.
Step 2 Click Edit.

The Edit Workflow area appears.
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Step 3 Edit the fields that you want to change.
Step 4 Click Save.

Delete Workflow

Procedure

Step 1 In the Manage Workflows gadget, select the workflow that you want to delete.

The Delete Workflow area appears.

Step 2 Click Delete.

A question appears asking you to confirm that you want to delete the selected workflow.

Step 3 Click Yes to confirm the deletion of the selected workflow.

Manage Security
The Cisco Finesse administration console and agent desktop support secure HTTP (HTTPS). To access the
administration console, enter the following URL in your browser (where FQDN is the fully qualified domain
name of your primary server):

https://FQDN:8445/cfadmin

Similarly, agents and supervisors can access their desktops as follows:

https://FQDN:8445/

For HTTPS access, you can eliminate browser security warnings by choosing to trust the self-signed certificate
provided with Finesse or uploading a CA certificate.

If you add custom gadgets that perform HTTPS requests to Finesse, you must add a certificate to the Finesse
server for that gadget.

Wildcard Certificates are not supported in Unified CCX.Note

HSTS
Finesse supports HTTP Strict Transport Security (HSTS) for increased security. HSTS is automatically enabled,
in which case the Finesse server sends HTTPS responses indicating to browsers that Finesse can only be
accessed using HTTPS. If users then try to access Finesse using HTTP instead of HTTPS, the browser changes
the connection to HTTPS before generating any network traffic. This functionality prevents browsers from
sending requests to Finesse using unencrypted HTTP before the server can redirect them.
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Trust Self-Signed Certificate
Trust the self-signed certificate provided by Finesse to eliminate browser warnings each time you sign in to
the administration console or agent desktop.

If you uploaded a CA certificate, you can skip this procedure.

Procedure

Step 1 In your browser, enter the URL for the administration console (https://FQDN of primary
server:portnumber/cfadmin) or the agent desktop (https://FQDN of primary server).

Step 2 Perform the steps in the following table for the browser you are using.
DescriptionOption

If you use
Internet
Explorer:

1. A page appears that states there is a problem with the website's security certificate.
Click Continue to this website (not recommended). This action opens the sign in
page for the administration console (or agent desktop). A certificate error appears in
the address bar of your browser.

2. Click Certificate Error, and then click View Certificates to open the Certificate
dialog box.

3. In the Certificate dialog box, click Install Certificate. This action opens the Certificate
Import Wizard.

If you use Internet Explorer 11, you must add Finesse to your trusted sites
before the Install Certificate option appears (Internet Options > Security >
Trusted Sites > Sites).

After you click Install Certificate, under Store Location, select Current
User to install the certificate for the current user only, or select Local
Machine to install the certificate for all Windows users who use this
computer.

Note

4. Click Next.

5. Select Place all certificates in the following store, and then click Browse.

6. Select Trusted Root Certification Authorities, and then click OK.

7. Click Next.

8. Click Finish.

9. If a Security Warning dialog box appears that asks if you want to install the certificate,
click Yes.

A Certificate Import dialog box that states the import was successful appears.

10. Click OK.

11. Enter your credentials, and then click Sign In.

If you use
Firefox:

1. A page appears that states this connection is untrusted.
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DescriptionOption

2. Click I Understand the Risks, and then click Add Exception.

3. In the Add Security Exception dialog box, ensure the Permanently store this exception
check box is checked.

4. Click Confirm Security Exception.

The page that states this connection is untrusted automatically closes and the
administration console (or agent desktop) loads.

5. Enter your credentials, and then click Sign In.

6. For the agent desktop only, an error appears that states Finesse cannot connect to the
Cisco Finesse Notification Service and prompts you to add a security exception for the
certificates issued by the Finesse server.

Click OK.

Obtain and Upload CA Certificate

This procedure is optional. If you are using HTTPS, you can choose to obtain and upload a CA certificate or
you can choose to use the self-signed certificate provided with Finesse.

Note

To eliminate browser security warnings each time you sign in, obtain Finesse certificate signed by a Certificate
Authority (CA). Use the Certificate Management utility from Cisco Unified Communications Operating
System Administration.

To open Cisco Unified Communications Operating System Administration, enter the following URL in your
browser:

https://hostname of primary UCCX server/cmplatform

Sign in using the username and password for the Application User account created during the installation of
Unified CCX.

Procedure

Step 1 Generate a CSR.
a) Select Security > Certificate Management > Generate CSR.
b) From the Certificate Name drop-down list, select tomcat.
c) Click Generate CSR.

You must not download the ECDSA certificate.

Step 2 Download the CSR.
a) Select Security > Certificate Management > Download CSR.
b) From the Certificate Name drop-down list, select tomcat.
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c) Click Download CSR.

Step 3 Generate and download a CSR for the secondary Unified CCX server.

To open Cisco Unified Operating System Administration for the secondary server, enter the following URL
in the address bar of your browser:

https://hostname of secondary UCCX server/cmplatform

Step 4 Use the CSRs to obtain the CA root certificate, intermediate certificate, and signed application certificate
from the Certificate Authority.

To set up the certificate chain correctly, you must upload the certificates in the order described in
the following steps.

Note

Step 5 When you receive the certificates, select Security > Certificate Management > Upload Certificate.
Step 6 Upload the root certificate.

a) From the Certificate Purpose drop-down list, select tomcat-trust.
b) In the Upload File field, click Browse and browse to the root certificate file.
c) Click Upload File.

Step 7 Upload the intermediate certificate.
a) From the Certificate Purpose drop-down list, select tomcat-trust.
b) In the Upload File field, click Browse and browse to the intermediate certificate file.
c) Click Upload File.

Step 8 Upload the application certificate.
a) From the Certificate Purpose drop-down list, select tomcat.
b) In the Upload File field, click Browse and browse to the application certificate file.
c) Click Upload File.

Step 9 After the upload is complete, restart the Cisco Unified CCX server on the primary node.

Delete the self-signed certificates from the clients certificate store. Then close the browser, relaunch,
and reauthenticate.

Note

Step 10 Upload the application certificate to the secondary Cisco Unified CCX server.

You do not need to upload the root and intermediate certificates to the secondary Unified CCX server. After
you upload these certificates to the primary server, they are replicated to the secondary server.

Step 11 Restart the Cisco Unified CCX server on the secondary node.

Add Certificate for HTTPS Gadget
Add a certificate for a secure HTTP (HTTPS) gadget to allow the gadget to load into the Finesse desktop and
successfully perform HTTPS requests to the Finesse server.

This process allows HTTPS communication between the Finesse gadget container and the third-party gadget
site for loading the gadget and performing any API calls that the gadget makes to the third-party server.
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A gadget that loads using HTTPSmay still use HTTP communication between that gadget and the application
server where it resides. If all traffic must be secure, the gadget developer must ensure that HTTPS is used to
make API calls to the application server.

Note

The certificate must be signed with a common name. The gadget URL in the desktop layout must use the
same name (whether it uses an IP address or a fully qualified domain name) as the name with which the
certificate is signed. If the certificate name and the name in the gadget URL do not match, the connection is
not trusted and the gadget does not load.

To find the certificate name, enter the gadget URL in your browser. Click the lock icon in the address bar and
then click View Details. Look for the common name field.

The Finesse host must be able to resolve this name using the DNS host that was entered during installation.
To verify that Finesse can resolve the name, run the CLI command “utils network ping <hostname>”.

Procedure

Step 1 Download the tomcat.pem certificate from the third-party gadget host.
Step 2 Upload the certificate to the designated Finesse system.

a) Sign in to Cisco Unified Operating System Administration on the primary Unified CCX node
(https://FQDN/cmplatform, where FQDN is the fully qualified domain name of the Unified CCX node).

b) Click Security > Certificate Management.
c) Click Upload Certificate/Certificate Chain.
d) From the Certificate Name drop-down list, select tomcat-trust.
e) Click Browse and navigate to the tomcat.pem file that you downloaded in the previous step.
f) Click Upload File.

Step 3 Restart Cisco Tomcat on the primary Unified CCX node.
Step 4 Restart Cisco Finesse Tomcat on the primary Unified CCX node.
Step 5 After synchronization is complete, restart Cisco Tomcat on the secondary Unified CCX node.
Step 6 Restart Cisco Finesse Tomcat on the secondary Unified CCX node.

Add Certificate for Multi-session Chat and Email
Add the SocialMiner certificate to the Finesse servers to allow communication between SocialMiner and
Finesse. After you complete this procedure, agents must accept certificates in the Finesse desktop before they
can use this gadget.

If SocialMiner is deployed with private certificates, agents cannot join chat rooms or reply to email messages
until they accept the SocialMiner certificates. If theManage Chat and Email gadget is deployed on theManage
Chat and Email tab of the Finesse desktop, agents may not realize that they need to accept the certificates.
Have agents check the tab where the gadget appears when they sign in to Finesse to make sure that certificates
are all accepted and the gadget loads correctly.

The steps to add a certificate for the Manage Chat and Email gadget are the same as the steps outlined in the
procedure Add Certificate for HTTPS Gadget.
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The procedure to add a certificate for an HTTPS gadget refers to the third-party gadget host. To add a certificate
for chat and email, perform the applicable steps on the SocialMiner server.

Note

Related Topics
Add Certificate for HTTPS Gadget, on page 60

Manage Finesse IP Phone Agent

Finesse IP Phone Agent
With Finesse IP Phone Agent (IPPA), agents and supervisors can access Finesse features on their Cisco IP
Phones as an alternative to accessing Finesse through the browser. Finesse IPPA supports fewer features than
the Finesse desktop in the browser, but it does allow agents and supervisors to receive and manage Finesse
calls if they lose or do not have access to a computer.

Supervisor Tasks

Finesse IPPA does not support supervisor tasks such as monitor, barge, and intercept, but supervisors can
sign in and perform all agent tasks on their IP Phones.

Administration Tasks

After you configure Finesse IPPA, the administration tasks that you perform for the Finesse desktop also
apply for the supported Finesse IPPA features. For example, the Call Variables Layouts that you configure
for the desktop also apply for Finesse IPPA, although the column layout is modified to fit the IP Phone screen.

Reason Code Limitations

• On the IP Phone, Finesse can display a maximum of 100 Not Ready, Wrap Up, or Sign Out reason codes.
If more than 100 codes are configured, the phone lists the first 100 applicable codes (global codes or
applicable team codes).

• When Finesse IPPA displays reason codes, some IP Phone models truncate the codes due to character
length limitations on the phone. To ensure they meet your requirements, verify the display of the reason
codes on all phone models in your environment.

HTTP Only

Finesse IPPA phone clients communicate with the Finesse server using HTTP only, whether or not HTTPS
access is enabled on Finesse.

Failure Behavior

Unlike the Finesse desktop, the Finesse IP Phone Agent does not automatically failover to the alternate Finesse
server. To resume normal operations in a failure scenario, the Finesse IPPA agents must exit from the current
Finesse IP Phone service and manually sign in to another configured Finesse service that connects to an
alternate Finesse server.
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To ensure continued operations in a failure situation, you must configure at least two Finesse IP Phone services
in Unified CM, each pointing to different Finesse servers.

One Button Sign In
With One Button Sign In, you can set up the Finesse IPPA phones with prepopulated agent ID, extension,
and password. In this case, agents can sign in to Finesse on the IP Phone without credentials just by selecting
Cisco Finesse from the Services menu.

Alternatively, you can set up One Button Sign In and prepopulate only a subset of agent credentials. For
example:

• You can prepopulate only the agent ID and extension, forcing the agents to manually enter their password
at sign-in for increased security.

• You can prepopulate only the extension, forcing agents to manually enter their ID and password at sign-in
(useful for agents who share the same phone).

You can use Unified CM Administration to prepopulate the agent credentials, or you can set up the agents
with access to the Unified CM Self Care Portal to prepopulate their own credentials.

The following table shows examples of how you can assign the responsibility of defining agent credentials
to the administrator or the agent, or share that responsibility between them.

Entered at Sign-In

(by Agent)

Prepopulated in Self Care
Portal

(by Agent)

Prepopulated in Unified
CM Administration

(by Administrator)

Example Set Up

id

password

-extensionAdministrator populates
the extension only

password-id

extension

Administrator populates
the ID and extension

-passwordid

extension

Agents enter password
only using Self Care
Portal

-id

extension

password

-Agents enter all
credentials using Self
Care Portal

passwordid

extension

-Agents enter ID and
extension only using Self
Care Portal

Finesse IP Phone Service Subscription Options
To set up access to Finesse on agent IP phones in Cisco Unified Communications Manager, you must create
the Finesse IP Phone service to which the phones can subscribe. To set up the Finesse service, you can choose
one of the following options:

Cisco Finesse
63

Cisco Finesse
One Button Sign In



• Set up an enterprise subscription to automatically subscribe all IP phones in the cluster to the Finesse
service. (Not supported with One Button Sign In.)

• Set up a manual subscription, and manually subscribe each IP phone to the Finesse service.

• Set up a manual subscription, and set up the agents with access to the Unified CM Self Care Portal to
subscribe to the Finesse service themselves.

The following table lists the Finesse IPPA configuration procedures and indicates which procedures are
required depending on the subscription option you choose.

Manual SubscriptionEnterprise SubscriptionFinesse IPPA Configuration
Procedures

Agents Manually Subscribe
Their Phones Using the Self
Care Portal

Administrator Manually
Subscribes the Phones

RequiredRequiredRequiredSet Up Application User, Web
Access, and HTTPS Server
Parameters, on page 64

RequiredRequiredRequiredConfigure Finesse IP Phone Service
in Unified CM, on page 66

Required only with One
Button Sign In

Required only with One Button
Sign In

Not applicableOne Button Sign In, on page 63

Optional. Allows the
administrator to enter agent
credentials for One Button
Sign In.

RequiredNot applicableSubscribe Agent Phones to Manual
Subscription Service, on page 70

RequiredOptional. Allows agents to enter
their own credentials for One
Button Sign In.

Not applicableSet Up Agent Access to the Self
Care Portal, on page 71

Set Up Application User, Web Access, and HTTPS Server Parameters
To support Finesse IPPA functionality, you must configure an application user in Unified Communications
Manager that is associated with all Finesse IPPA phones. And for proper Finesse IPPA operation, you must
also set the Web Access and HTTPS Server parameters in Unified CM.

These steps are required for both manual and enterprise subscriptions.

Before you begin

Set up call capabilities for the agent phones in Cisco Unified Communications Manager.

Procedure

Step 1 Set the following parameters in Unified CM:

• Set theWeb Access parameter to Enabled.
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• Set the HTTPS Server parameter to HTTP and HTTPS Enabled.

To set these parameters in Cisco Unified CM Administration, use either of the following pages:

• Phone Configuration page (Product Specific Configuration portion of page): choose Device > Phone.

• Enterprise Phone Configuration page: choose System > Enterprise Phone Configuration.

Step 2 Configure an application user in Unified Communications Manager.
a) In Cisco Unified Communications Manager Administration, select User Management > Application

User.
b) Click Add New.
c) Under User Information, enter a user ID and password for the new user.

The password must be 95 characters or less and must contain ASCII characters only.

d) Under Device Information, in the Available Devices pane, select all phones that Finesse IP Phone Agents
will use and move them to the Controlled Devices pane using the arrows.

e) Under Permissions Information, click Add to Access Control Group.
f) From the list of search results, select Standard CTI Enabled and Standard CTI Allow Control Of All

Devices and then click Add Selected.

The application user is added to the Standard CTI Enabled and Standard CTI AllowControl Of All Devices
groups.

g) Click Save at the bottom of the page.

In UCCX deployments, usage of an existing RMCM User for Finesse IPPA is known to cause
problems in functionality, however, the physical phones must be associated with the RMCM User.

Note

Step 3 Enter the application user's credentials in the Finesse IP Phone Agent Settings gadget.
a) Sign in to the Cisco Finesse Administration Console.
b) Choose Settings > IP Phone Agent Settings.
c) Under Phone URL Authentication Settings, enter the same username and password that you entered in

Unified CM for the application user.

The password must be 95 characters or less and must contain ASCII characters only.

d) Click Save.
e) Restart Cisco Finesse Tomcat on the primary Unified CCX node.
f) After replication is complete, restart Cisco Finesse Tomcat on the secondary Unified CCX node.

For information to check the replication status, see Step 3 of Prepare System for IP Address/host name
Change.

For Finesse IP Phone Agent (FIPPA) from 11.0 (1) onwards, the User Device Profile (UDP) must
be associated with the FIPPA Application User along with the physical phones for agents using
Extension Mobility. The Finesse Service URL must use the complete FQDN of the UCCX server.

Note

Related Topics
Prepare System for IP Address/host name Change
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Configure Finesse IP Phone Service in Unified CM
The following procedure describes the steps required for both manual and enterprise subscription.

Procedure

Step 1 Log in to the Cisco Unified Communications Manager Administration using administrator credentials.
Step 2 From the Communications Manager menu, select Device > Device Settings > Phone Services.

Step 3 On the IP Phone Services page, click Add New to create a new IP phone service.

Step 4 In the Service Name field, enter Cisco Finesse (or another service name that is appropriate for your
environment).

Step 5 In the Service URL field, enter:

http://Finesse FQDN:8082/fippa/#DEVICENAME#

where Finesse FQDN is the fully qualified domain name (FQDN) of your primary Finesse server.

Step 6 Ensure that the Service Category is set to XML Service, and the Service Type is set to Standard IP Phone
Service.

Step 7 Check the Enable check box.
Step 8 Do one of the following:

• To automatically subscribe all phones in the cluster to the Finesse service, check the Enterprise
Subscription check box, and click Save. Agents and supervisors can now access Cisco Finesse by
selecting it from the Services menu on subscribed IP phones.

One Button Sign In is not supported with enterprise subscriptions.Note
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Figure 1: Finesse Service Configuration with Enterprise Subscription

• To subscribe only the desired phones to the Finesse service manually, leave theEnterprise Subscription
check box unchecked and click Save.
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Figure 2: Finesse Service Configuration Without Enterprise Subscription

Step 9 With a two-node Finesse setup (primary and secondary Finesse servers), perform the preceding steps again
to create a secondary Finesse service that points to the secondary Finesse server.When you create the secondary
service, note the following procedural differences:

• At Step 4, in the Service Name field, enter a name that distinguishes the secondary service from the
primary service, such as Cisco Finesse Secondary.

• At Step 5, in the Service URL field, replace Finesse FQDN with the FQDN of the secondary server.

Since Finesse IPPA works only over HTTP, avoid using Secured Phone URL Parameters in Unified
CM.

Note

Add Service Parameters for One Button Sign In
With One Button Sign In, for any agent credentials that you want prepopulated, youmust set up corresponding
service parameters in Unified CM.

Only perform this procedure if you are setting up One Button Sign In. Otherwise, skip this procedure.
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Procedure

Step 1 From Cisco Unified Communications Manager Administration, select the Finesse phone service (under
Device > Device Settings > Phone Services).

Step 2 Click New to the right of the Parameters box.

The Configure Cisco IP Phone Service Parameter page displays.

Step 3 Set up service parameters for the agent id, extension, and password credentials in accordance with the following
table. Enter only the parameters that you want prepopulated for the agents. For each parameter, enter the
required field values and click Save. To add additional parameters, click Add New and enter the required
values.

DescriptionField

Enter one of the following parameter names in lowercase exactly as follows:

• id

• extension

• password

The values entered are the exact query string parameters used for the subscription
URL.

Parameter Name

Enter a descriptive parameter name; for example, id, extension, and password.Parameter Display
Name

Leave the default value blank for all parameters.Default Value

Enter a description of the parameter. The user can access this text when they
subscribe to the service.

Parameter Description

If the administrator will prepopulate the parameter in Unified CMAdministration,
check the Parameter is Required check box.

However, if the agent will prepopulate the parameter in the Self Care Portal, two
options are available:

• If the agents will prepopulate all defined parameters, check the Parameter
is Required check box for each parameter.

• If the agent and administrator will share the responsibility of prepopulating
the parameters, set only the administrator-defined parameters as required.
This configuration ensures that the administrator can save the subscription
without prepopulating all parameters. In this case, the administrator first
prepopulates the required parameters, and then the agents prepopulate the
nonrequired parameters.

Parameter is Required

Check this check box for the password only.

This check box masks the password entries in the Self Care Portal, to display
asterisks rather than the user entry.

Parameter is a
Password (mask
contents)
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When you save the last parameter, click Save and Close.

What to do next

You can prepopulate the agent credentials when you subscribe the agent phones, or the agents can prepopulate
their own credentials using the Unified CM Self Care Portal.

Subscribe Agent Phones to Manual Subscription Service
If you set up the Finesse service as a manual subscription, you can subscribe the agent phones to the Finesse
service in Unified CM and optionally define agent credentials for One Button Sign In.

If you prefer to allow the agents subscribe to the Finesse service using the Self Care Portal and prefer not to
specify One Button Sign In credentials for the agents, you can skip this procedure.

Procedure

Step 1 From the menu bar, select Device > Phone.
Step 2 Select the phone that you want to subscribe to the Finesse service.
Step 3 From theRelated Links drop-down list on the upper right side of the window, select Subscribe/Unsubscribe

Services and click Go.

The Subscribed IP phone services window displays for this phone.

Step 4 From the Select a Service drop-down list, select Cisco Finesse.
Step 5 Click Next.
Step 6 (Applicable for One Button Sign In only) Enter values for any of the defined service parameters (id, password,

and extension) that you do not want the agents to enter using the Self Service Portal or at sign-in.
Step 7 Click the Subscribe button to subscribe this phone to the Cisco Finesse service.

The Cisco Finesse service displays in the Subscribed Services list.

Cisco Finesse
70

Cisco Finesse
Subscribe Agent Phones to Manual Subscription Service



Step 8 Click Save.

The subscribed agents or supervisors can now access Cisco Finesse by selecting it from the Services menu
on their IP phones.

Step 9 With a two-node Finesse setup (primary and secondary Finesse servers), perform this procedure again to also
subscribe the phones to the secondary Finesse service that points to the secondary Finesse server.

Set Up Agent Access to the Self Care Portal
You can optionally set up the agents with access to the Unified CM Self Care Portal to prepopulate their own
credentials and to subscribe to the Finesse service.

If you are not setting up One Button Sign In, or not enabling the agents with access to the Self Care Portal,
skip this procedure.

Procedure

Step 1 From the Unified CM Administration page, select System > Enterprise Parameters.
Step 2 Under the Self Care Portal Parameters, in the Self Care Portal Default Server field, select the IP address of

the Unified CM Publisher server from the drop-down list and click Save.
Step 3 Select User Management > End User.
Step 4 Select the user that you want to set up with access to the User Care Portal.
Step 5 Under Permissions Information, click Add to Access Control Group.
Step 6 From the list of Access Control groups displayed, check Standard CCMEnd Users and clickAdd Selected.
Step 7 Click Save.

With access enabled to the Self Care Portal, agents can sign in to the portal at http://<UCM address>/ucmuser
to subscribe to the Finesse service and enter their own credentials under Phones > Phone Settings > Services.

In a two-node Finesse setup with two services configured, the agents must enter their credentials on both the
primary and secondary Finesse services.

Note

CTI Failover
Finesse follows the active/standby model of Unified CCX. Finesse on the active Unified CCX node is
"IN_SERVICE" and Finesse on the standby node is "OUT_OF_SERVICE".

A loss of connection to the CTI server can occur due to the following:

• Finesse misses three consecutive heartbeats from the connected CTI server.

• Finesse encounters a failure on the socket opened to the CTI server.

• The CTI server is not active on the node (Unified CCX is standby on the node).
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When Finesse loses connection to the CTI server, Finesse attempts to reconnect until it makes a successful
connection to the CTI server.

Cisco Finesse connects successfully through CTI to the node where the Unified CCX Engine is currently
master. Agents should log in to Finesse on that node.

When the master Unified CCX Engine fails, Finesse establishes a connection with the Unified CCX Engine
on the other node, and agents must log in to other node.

Finesse IP Phone Agent Failover
With a two-node Finesse setup (primary and secondary Finesse servers), if the server that an agent is connected
to goes out of service, the Finesse IP Phone Agent (IPPA) displays a notification that the server is unavailable.
Finesse IPPA continues to check whether the current Finesse server recovers its state, and notifies the agent
if it reconnects.

Finesse IPPA attempts to reconnect to the server every 5 seconds and declares it out of service after three
failed attempts. The total time to go out of service is approximately 15 seconds.

Unlike the Finesse desktop, Finesse IPPA does not check whether the alternate Finesse server is available.
To connect to an alternate Finesse server, the agent must exit the current Finesse service, and manually sign
in to the alternate Finesse service.

The Finesse IPPA failover logic has two triggers to detect failure:

• Finesse IPPA receives a SystemInfo event that the current server is OUT_OF_SERVICE.

Finesse IPPA polls SystemInfo every 5 seconds to check whether the Finesse server is in service. After
three attempts, if the Finesse server is not in service, Finesse IPPA displays a server unavailable message
to the agent.

• Finesse IPPA receives an XMPP connection notification that the XMPP connection is disconnected.

Finesse IPPA tries every 5 seconds to reconnect with the XMPP server. After three attempts, if the XMPP
connection cannot be reestablished, Finesse IPPA displays a server unavailable message to the agent.

While the agent is still signed in to the current service, Finesse IPPA continues attempting to reestablish the
connections with the Finesse and XMPP servers. If they both resume service, Finesse IPPA displays the sign-in
screen and the agent can sign in again and continue as normal.

Otherwise, the agent must exit the current Finesse service and try to connect using an alternate Finesse service.

Finesse IPPA failover can occur for the following reasons:

• The Finesse Webapp Service goes down.

• The Cisco Finesse Notification Service goes down.

• The Finesse connection to the CTI server goes down.

Backup and Restore
The Unified CCX backup and restore component also backs up and restores Finesse configurations and data.

For more information about backup and restore, see Cisco Unified Contact Center Express Administration
Guide at https://www.cisco.com/c/en/us/support/customer-collaboration/unified-contact-center-express/
products-maintenance-guides-list.html
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.

Additional Language Support
For the list of languages that are supported by Finesse, see the Unified CCXCompatibility related information,
located at:

https://www.cisco.com/c/en/us/support/customer-collaboration/unified-contact-center-express/
products-device-support-tables-list.html.

If you want to use the Finesse desktop interface in a language other than English, download and install the
language COP file. For more information, see the “COP File” section of the Cisco Unified Contact Center
Express Install and Upgrade Guide, located at:

https://www.cisco.com/c/en/us/support/customer-collaboration/unified-contact-center-express/
products-installation-guides-list.html.

Cisco Finesse Agent and Supervisor Desktop
Cisco Finesse Desktop provides easy access to the applications and information sources from a single
customizable cockpit. Providing this unique access to information helps the agents deliver fast and accurate
service.

For more information about Cisco Finesse Agent and Supervisor Desktop , see Cisco Finesse Agent and
Supervisor Desktop User Guide for Cisco Unified Contact Center Express at https://www.cisco.com/en/US/
products/sw/custcosw/ps1846/products_user_guide_list.html.

Call Manager-Based Call Recording Using Cisco MediaSense
Cisco Finesse in Unified CCX supports call recording using Cisco MediaSense.

MediaSense is the media-capture platform for Cisco Unified Communications.

To use MediaSense, perform the following procedures:

1. Configure Cisco MediaSense with Unified CM, on page 74
2. Upload Cisco MediaSense Certificate to Unified CCX Server, on page 74
3. Upload MediaSense Recording License, on page 75
4. Configure MediaSense as a Recording Server, on page 75
5. Call Recording Through Workflow, on page 75
6. Configure MediaSense Search and Play Gadget, on page 76

After performing all of the procedures, restart the Unified CCX server. In high availability deployment, restart
both of the nodes.

Note
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Configure Cisco MediaSense with Unified CM
For information about configuring Cisco MediaSense with Unified CM, see the "Unified CM provisioning
for Cisco MediaSense" section in the Installation and Administration Guide for Cisco MediaSense at
https://www.cisco.com/en/US/products/ps11389/prod_installation_guides_list.html.

Upload Cisco MediaSense Certificate to Unified CCX Server
To establish connection with Cisco MediaSense securely, you must upload the Cisco MediaSense certificate
to Unified CCX server.

Procedure

Step 1 Download the tomcat.pem certificate from the Cisco MediaSense server.
a) Sign in to Cisco Unified Operating System Administration on the Cisco MediaSense host (https://host or

IP address/cmplatform/showHome.do, where host or IP address is the hostname or IP address of the
Cisco MediaSense server).

b) Select Security > Certificate Management.

The Certificate List screen appears.

c) Click Find.

A list of certificates appears.

d) In the Common Name column, click the link of the certificate you want to download.

The Certificate Name must be tomcat-trust and the Certificate Type must be trusts-cert. The
Certificate Details pop-up window appears.

Note

e) Click Download .PEM File.

A pop-up window appears.

f) Select Save File radio button and Click OK.

The file gets saved on your system.

Step 2 Upload the certificate to the designated Unified CCX server.
a) Sign in to Cisco Unified Operating System Administration on the primary Unified CCX node (http://host

or IP address/cmplatform, where host or IP address is the hostname or IP address of the Unified CCX
node).

b) Choose Security > Certificate Management.
c) Click Upload Certificate/Certificate Chain.
d) From the Certificate Name drop-down list, select tomcat-trust.
e) Click Browse and navigate to the tomcat.pem file that you downloaded in the previous step.
f) Click Upload File.
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For more information about certificate management, see the Certificate Management Menu section of
theCisco Unified Operating System Administration Guide, at https://www.cisco.com/en/US/products/sw/
custcosw/ps1846/products_installation_and_configuration_guides_list.html.

Upload MediaSense Recording License
To use the MediaSense recording feature, you must purchase the Unified CCX recording license and upload
it to the Unified CCX server.

For information about how to upload the license, see Upload Licenses.

Related Topics
Upload Licenses

Configure MediaSense as a Recording Server
For information about configuring MediaSense as a recording server, see Recording Configuration.

Related Topics
Recording Configuration

Call Recording Through Workflow
Use the HTTP Request action to invoke the Finesse Recording API after the call is answered.

Procedure

Step 1 Create an HTTP Request Recording action:
a) In the Manage Workflow Actions area, click New.
b) In the Name box, enter a name for the action.
c) From the Type drop-down list, select HTTP Request.
d) From the Handled By drop-down list, select Finesse Desktop.
e) From the Method drop-down list, select PUT.
f) From the Location drop-down list, select Finesse.
g) In the Content Type box, enter application/xml.
h) In the URL box, enter the following:

/finesse/api/Dialog/

i) Click the tag icon at the right of the box and select dialogId to add it to the URL.
j) In the Body box, enter the following:
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To add the extension, click the tag icon and select extension.

Example:

Step 2 Click Save to save workflow action.
Step 3 Add a Call Answered Workflow that executes the HTTP Request Recording action that you created in the

previous step.

The Call AnsweredWorkflow can be used to trigger an HTTP Request Recording action for inbound
calls, agent-initiated outbound calls, and Predictive, Progressive, and Direct Preview outbound calls.

Note

Step 4 Assign the workflow to the teams that you would like to record.

Configure MediaSense Search and Play Gadget

Before you begin

In the MediaSense server, you must have already configured Unified CM, Cisco Finesse, and MediaSense
API.

Procedure

Step 1 Sign in to the Cisco Finesse administration console.
Step 2 Click the Desktop Layout tab.
Step 3 Find the MediaSense tab and gadget in the layout XML. Update the layout according to the comments in the

layout.
<!--

The following Tab and Gadget are for MediaSense. They are *ONLY* supported with
MediaSense.

If you are not using MediaSense,then remove them. If you are using MediaSense and wish
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to show
Recording Management, then do the following:

1) Remove these comments leaving the tab and gadget
2) Replace all instances of "my-mediasense-server" with the Fully Qualified Domain

Name of your MediaSense Server.

IMPORTANT NOTE:
- In order for this Gadget to work, you must have performed all documented

prerequisite
steps.

<tab>
<id>manageRecordings</id>
<label>finesse.container.tabs.supervisor.manageRecordingsLabel</label>
<gadgets>

<gadget>https://my-mediasense-server:8440/ora/gadget/MediaSenseGadget.xml</gadget>
</gadgets>

</tab>
-->

Replace all instances of my-mediasense-server with https://<Fully Qualified Domain Name

of your MediaSense Server>/ora/gadget/MediaSenseGadget.xml.

Note

Example:
https://abcd-ef-gh102.abc.com:8440/ora/gadget/MediaSenseGadget.xml

Step 4 Click Save.

The supervisor must log out and log in again to Cisco Finesse Supervisor Desktop to access
MediaSense.

Note

Step 5 Sign in to Cisco Finesse desktop as a supervisor and confirm that MediaSense gadget is accessible.
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